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Digital TV (DVB-T) Notice
1. 	 Functionalities related to Digital TV(DVB) are only available in countries/areas where DVB-T (MPEG2 and MPEG4 AVC) digital 

terrestrial signals are broadcasted or where you are able to access to a compatible DVB-C(MPEG2 and MPEG4 AAC) cable-
TV service. Please check with your local dealer the possibility to receive DVB-T or DVB-C signal.

2.	 DVB-T is the DVB European consortium standard for the broadcast transmission of digital terrestrial television and DVB-
C is that for the broadcast transmission of digital TV over cable. However, some differentiated features like EPG (Electric 
Program Guide), VOD (Video on Demand) and so on, are not included in this specification. So, they cannot be workable at this 
moment. 

3.	 Although this TV set meets the latest DVB-T and DVB-C standards, as of [August, 2008], the compatibility with future DVB-T 
digital terrestrial and DVB-C digital cable broadcasts cannot be guaranteed. 

4.	 Depending on the countries/areas where this TV set is used some cable-TV providers may charge an additional fee for such a 
service and you may be required to agree to terms and conditions of their business.

5.	 Some Digital TV functions might be unavailable in some countries or regions and DVB-C might not work correctly with some 
cable service providers.

6.	 For more information, please contact your local Samsung customer care centre.

Precautions When Displaying a Still Image 
A still image may cause permanent damage to the TV screen

Do not display still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 
This image retention is also known as screen burn. To avoid such image retention, reduce the degree of brightness and 
contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 
a game console may cause a similar effect to the screen. Damages caused by the above effect are not 
covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 
prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.  

© 2009 Samsung Electronics Co., Ltd. All rights reserved.
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License

TruSurround HD, SRS and  symbol are trademarks of SRS Labs, Inc. TruSurround HD technology is 
incorporated under license from SRS Labs, Inc.

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are trademarks of 
Dolby Laboratories.
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Setting up Your TV

Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 
Product design and specifications may be changed without notice in order to enhance product performance.

Viewing the Control Panel
The product colour and shape may vary depending on the model.
The front panel buttons can be activated by touching it with your finger.

1	 P (POWER): Press to turn the TV on and off.
2	 POWER INDICATOR: Blinks and turns off when the power is on and lights up in stand-by mode.
3	 z: Press to change channels. In the on-screen menu, use the z buttons as you would use the ▼ and ▲ 

buttons on the remote control.
4	 Y: Press to increase or decrease the volume. 

In the on-screen menu, use the Y buttons as you would use the ◄ and ► buttons on the remote control.
5	 MENU: Press to see an on-screen menu of your TV’s features.
6	 SOURCE E: Toggles between all the available input sources. In the on-screen menu, use this button as you would use the 

ENTERE button on the remote control.
7	R EMOTE CONTROL SENSOR: Aim the remote control towards this spot on the TV.
8	 SPEAKERS
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Accessories

Remote Control & Batteries (AAA x 2) Power Cord Cover-Bottom

Warranty Card / Safety Guide (Not 
available in all locations)

Stand Screw (M4 X L16)
(Depending on the model) Cleaning Cloth Holder-Wire Cable

(Depending on the model)

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.
The items colour and shape may vary depending on the model.

¦
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Viewing the Connection Panel

The product colour and shape may vary depending on the model.
1	 COMPONENT IN 

Connects Component video / audio.
2	 HDMI IN 1, 2, 3(DVI), 4 / DVI AUDIO IN

Connects to the HDMI jack of a device with an HDMI output.
No sound connection is needed for an HDMI to HDMI connection.
What is HDMI?
HDMI(High-Definition Multimedia Interface), is an interface that enables the transmission of digital audio and video signals 
using a single cable.
The difference between HDMI and DVI is that the HDMI device is smaller in size and has the HDCP (High Bandwidth 
Digital Copy Protection) coding feature installed.
The TV may not output sound and pictures may be displayed with abnormal colour when DVD / Blu-ray player / Cable 
Box / Satellite receiver (Set-Top Box) supporting HDMI versions older than 1.3 are connected. When connecting an older 
HDMI cable and there is no sound, connect the HDMI cable to the HDMI IN 3(DVI) jack and the audio cables to the DVI 
AUDIO IN jacks on the back of the TV. If this happens, contact the company that provided the DVD / Blu-ray player / 
Cable Box / Satellite receiver (Set-Top Box) to confirm the HDMI version, then request an upgrade.
Use the HDMI IN 3(DVI) jack for DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI adapter 
(DVI to HDMI) for video connection and the DVI AUDIO IN jacks for audio. When using an HDMI / DVI cable connection, 
you must use the HDMI IN 3(DVI) jack.
HDMI cables that are not 1.3 may cause annoying flicker or no screen display.

3	 PC IN [PC] / [AUDIO]
Connects to the video and audio output jacks on your PC.

If your PC supports an HDMI connection, you can connect this to the HDMI IN 1, 2, 3(DVI) or 4 terminal.
If your PC supports a DVI connection, you can connect this to the HDMI IN 3(DVI) / DVI AUDIO IN terminal.

4	 ANT IN
Connects to an antenna or cable TV system.

5	 KENSINGTON LOCK (depending on the model)
The Kensington Lock (optional) is a device used to physically fix the system when used in a public place. If you want to use a 
locking device, contact the dealer where you purchased the TV.

The location of the Kensington Lock may be different depending on its model.
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6	 H(HEADPHONE)
Headphone may be connected to the headphone output on your set. While the head phone is connected, the sound from the 
built-in speakers will be disabled.

Using the sound function is restricted when connecting headphones to the TV.
Prolonged use of headphones at a high volume may damage your hearing.
You will not hear sound from the speakers when you connect headphones to the TV.
The headphone volume and TV volume are adjusted separately.

7	 DIGITAL AUDIO OUT (OPTICAL)
Connects to a Digital Audio component such as a Home theatre receiver.

When a Digital Audio System is connected to the DIGITAL AUDIO OUT (OPTICAL) jack: Decrease the volume of the TV 
and adjust the volume level with the system’s volume control.
5.1CH audio is possible when the TV is connected to an external device supporting 5.1CH.
When the receiver (home theatre) is set to On, you can hear sound output from the TV’s Optical jack. When the TV is 
displaying a DTV(air) signal, the TV will send out 5.1 channel sound to the Home theatre receiver. When the source is a 
digital component such as a DVD / Blu-ray player / Cable Box / Satellite receiver (Set-Top Box) and is connected to the 
TV via HDMI, only 2 channel sound will be heard from the Home Theatre receiver. If you want to hear 5.1 channel audio, 
connect the digital audio out jack on DVD / Blu-ray player / Cable Box / Satellite receiver (Set-Top Box) directly to an 
Amplifier or Home Theatre, not the TV.

8	 SERVICE
Connector for service only.

9	 AUDIO OUT [R-AUDIO-L]
Connects to the audio input jacks on your Amplifier/Home theatre.
When an audio amplifier is connected to the AUDIO OUT [R-AUDIO-L] jacks: Decrease the volume of the TV and adjust the 
volume level with the Amplifier’s volume control.

0	 EXT1, 2
Inputs or outputs for external devices, such as VCR, DVD, video game device or video disc players.

In EXT Mode, DTV Out supports MPEG SD Video and Audio only.
Input/Output Specification

Connector Input Output
Video Audio (L / R) RGB Video + Audio (L / R)

EXT 1 O O O Only TV or DTV output is available.
EXT 2 O O X Output you can choose.

!	 AV IN [VIDEO] / [R-AUDIO-L]
Video and audio inputs for external devices, such as a camcorder or VCR.

@	 USB
Connector for software upgrades and Media Play, etc.

#	 COMMON INTERFACE Slot
When not inserting ‘CI CARD’ in some channels, ‘Scrambled Signal’ is displayed on the screen.
The pairing information containing a telephone number, CI CARD ID, Host ID and other information will be displayed in 
about 2~3 minutes. If an error message is displayed, please contact your service provider.
When the channel information configuration has finished, the message ‘Updating Completed’ is displayed, indicating that 
the channel list is now updated.
You must obtain a CI CARD from a local cable service provider. Remove the CI CARD by carefully pulling it out with your 
hands since dropping the CI CARD may cause damage to it.
Insert the CI-Card in the direction marked on it.
The place of the COMMON INTERFACE Slot may be different depending on its model. 
CAM is not supported in some countries and regions, check with your authorized dealer.
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Viewing the Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

1	 POWER : Turns the TV on and 
off.

2	 NUMERIC BUTTONS :  Press to 
change the channel.

3	 E : Performs the same function 
as the ENTERE button of 
the directional buttons. When 
switching channels with the 
numeric buttons, and you press 
the channel number and then the 
ENTERE button, the channel is 
immediately switched.

4	 Y : Press to increase or 
decrease the volume.

5	 SOURCE : Press to display 
and select the available video 
sources.

6	 CH LIST : Used to display 
Channel Lists on the screen.

7	 TOOLS : Use to quickly select 
frequently used functions.

8	 INFO : Press to display 
information on the TV screen.

9	 COLOURS BUTTONS : Use 
these buttons in the Channel 
list, Media Play menu, etc.

!	 DUAL : Sound effect selection
@	 Use these buttons in the Media 

Play and Anynet+ modes. (∏: 
This remote can be used to 
control recording on Samsung 
recorders with the Anynet+ 
feature)

#	 TV : Selects the TV mode 
directly.

$	 PRE-CH : Enables you to return 
to the previous channel you were 
watching.

%	 MUTE M : Press to temporarily 
cut off the sound. 

^	 > P < : Press to change 
channels.

&	 MENU : Displays the main on-
screen menu.

*	 FAV.CH : Used to display 
Favourites Channel Lists on the 
screen.

(	 RETURN : Returns to the 
previous menu

)	 UP▲ / DOWN▼ / LEFT◄ / 
RIGHT► / ENTERE : Use to 
select on-screen menu items and 
change menu values.

a	 EXIT : Press to exit the menu.
b	 P.SIZE : Picture size selection.
c	 MEDIA.P : Allows you to play 

music files and pictures.
d	 SUBT. : Digital subtitle display
e	 GUIDE : Electronic Programme 

Guide (EPG) display

Teletext Functions
5	 0 : Teletext mode selection 

(LIST / FLOF)
6	 8 : Teletext store
7	 4 : Teletext size selection
8	 5 : Teletext reveal
9	 Fastext topic selection
0	 / : Alternately select 

Teletext, Double, or Mix.
#	 : : Exit from the Teletext 

display
$	 1: Teletext sub page
^	 2: Teletext next page

3: Teletext previous page
&	 6 : Teletext index
(	 9 : Teletext hold
a	 7 : Teletext cancel
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Installing Batteries in the Remote Control

1.	 Lift the cover at the back of the remote control upward as shown in the figure.
2.	 Install two AAA size batteries. 

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 
compartment.

3.	 Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using the 
remote control for a long time. 

If the remote control doesn’t work, check the following:
Is the TV power on? 
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?OPERATION

Viewing the menus
Before using the TV, follow the steps below to learn how to navigate the menu in order to select and adjust different functions.

  

Operation the OSD (On Screen Display)
The access step may differ depending on the selected menu.
1.	 Press the MENU button.

2.	 The main menu appears on the screen. The menu’s left side has icons : Picture, Sound, 
Channel, Setup, Input, Application, Support.

3.	 Press the ▲ or ▼ button to select one of the icons.

4.	 Then press the ENTERE button to access the icon’s sub-menu.
5.	 Press the ▲ or ▼ button to select the icon’s submenu.

6.	 Press the ◄ or ► button to decrease or increase the value of a particular item. The 
adjustment OSD may differ depending on the selected menu.

7.	 Press the ENTERE button to complete the configuration. Press the EXIT button to exit.

¦
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N
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❑

MENU Button
Display the main on-screen menu.

ENTERE / DIRECTION Button
Move the cursor and select an 

item. Select the currently selected 
item. Confirm the setting.

RETURN Button
Return to the previous menu.

EXIT
Exit the on-screen menu.

Mode	 : Standard	 ▶

Backlight	 : 7
Contrast	 : 95
Brightness	 : 45
Sharpness	 : 50
Colour	 : 50
Tint (G/R)	 : G50/R50
Advanced Settings

Picture

Mode	 : Standard

Backlight	 : 7	 ▶

Contrast	 : 95
Brightness	 : 45
Sharpness	 : 50
Colour	 : 50
Tint (G/R)	 : G50/R50
Advanced Settings
Picture Options

Picture

7

 U Move    L Adjust     E Enter     R Return

      ▲
Backlight
      ▼

Help icon
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Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and subsequently.
1.	 Press the POWER button on the remote control. 

You can also use the POWERP button on the TV. 
The message Выбор языка экранного меню. is displayed.

2.	 Press the ENTERE button. Select the appropriate language by pressing the ▲ or ▼ 
button. Press the ENTERE button to confirm your choice.

3.	 Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button.
We recommend setting the TV to Home Use mode for the best picture in your home 
environment.
Store Demo mode is only intended for use in retail environments.
If the unit is accidentally set to Store Demo mode and you want to return to Home 
Use (Standard): Press the volume button on the TV. When the volume OSD is displayed, press and hold the MENU 
button on the TV for 5 seconds.

4.	 Press the ENTERE button. Select the appropriate country by pressing the ▲ or ▼ button. Press the ENTERE button to 
confirm your choice.

5.	 Press the ▲ or ▼ button to select Air or Cable, then press the ENTERE button.
Air: Air antenna signal.
Cable: Cable antenna signal.

6.	 Press the ▲ or ▼ button to select the channel source to memorize. Press the ENTERE button to select Start.
When setting the antenna source to Cable, a step appears allowing you to set a value for the digital channel search. For 
more information, refer to Channel → Auto Store.
Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.
The channel search will start and end automatically.
Press the ENTERE button at any time to interrupt the memorization process.
After all the available channels are stored, the message Set the Clock Mode. is displayed.

7.	 Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then Press the ENTERE button.
If you select Manual, Set current date and time is displayed. 
If you have received a digital signal, the time will be set automatically. If not, select Manual to set the clock.

8.	 The description for the connection method providing the best HD screen quality is displayed. Check the description and press 
the ENTERE button.

9.	 The message Enjoy your viewing is displayed. When you have finished, press the ENTERE button.

If you want to reset this feature...
1.	 Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, 

then press the ENTERE button.
2.	 Press the ENTERE button again to select Plug & Play.
3.	 Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’.

If you want to change PIN number, use the Change PIN function. 
The Plug & Play feature is only available in the TV mode.

¦
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Plug & Play	 	 ▶

Language	 : English
Time
Game Mode	 : Off
Child Lock	 : On
Change PIN
Parental Lock
Subtitle

Setup
Выбор языка экранного меню.

Язык 	 : Русский 	 	 ▶

E Вход

Plug & Play
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CHANNEL

Channel Menu

Country

Analogue Channel
You can change the country for analogue channels.

Digital Channel
You can change the country for digital channels.

The PIN number input screen appears. Enter your 4 digit PIN number.

Auto Store
You can scan for the frequency ranges available to you (and availability depends on your country). Automatically allocated 
programme numbers may not correspond to actual or desired programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.

Air / Cable
Antenna source to memorize

Digital & Analogue: Digital and Analogue channels.
Digital: Digital channels.
Analogue: Analogue channels.

When selecting Cable → Digital & Analogue or Cable → Digital:
Provide a value to scan for cable channels.

Search Mode → Full / Network /Quick
Quick

Network ID: Displays the network identification code.
Frequency: Displays the frequency for the channel. (Differs in each country)
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

Scans for all channels with active broadcast stations and stores them in the TV’s memory.
If you want to stop Auto Store, press the ENTERE button.
The Stop Auto Store? message will be displayed.
Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

Manual Store
Scans for a channel manually and stores it in the TV’s memory.
If a channel is locked using the Child Lock function, the PIN input window appears.

Digital Channel
Manual store for digital channels.

Digital Channel is only available in DTV mode.
Channel: Set the Channel number using the ▲, ▼ or number (0~9) buttons.
Frequency: Set the frequency using the number buttons.
Bandwidth: Set the bandwidth using the ▲, ▼ or number (0~9) buttons.
When it has finished, channels are updated in the channel list.

Analogue Channel
Manual store for analogue channel.

Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.
Colour System → Auto / PAL / SECAM / NTSC4.43: Sets the colour system value using the ▲ or ▼ button.
Sound System → BG / DK / I / L: Sets the sound system value using the ▲ or ▼ button.
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Country	 	 ▶

Auto Store
Manual Store
Cable Search Option
Full Guide
Mini Guide
Default Guide	 : Full Guide
Channel List

Channel
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Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 
(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.

You can also select the channel number directly by pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect the sound standard required.
Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.

Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.
Channel mode
P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 
numbers from P00 to P99. You can select a channel by entering the position number in this mode.
C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 
mode.
S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

Cable Search Option (depending on the country)
Using this function, you can manually add the channel range to be scanned by Full Search mode of the Auto Store function.

Freq.Start (Frequency Start): Set the start frequency  (Differs in each country)
Freq.Stop (Frequency Stop): Set the stop frequency (Differs in each country)
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

Full Guide / Mini Guide
The EPG (Electronic Programme Guide) information is provided by the broadcasters. Programme entries may appear blank or out 
of date as a result of the information broadcast on a given channel. The display will dynamically update as soon as new information 
becomes available.

You can also display the guide menu simply by pressing the GUIDE button. (To configure the Default Guide, refer to the 
descriptions.)

Full Guide
Displays the programme information as time ordered One hour segments. Two hours of programme information is displayed which 
may be scrolled forwards or backwards in time.

Mini Guide
The information of each programme is displayed by each line on the current channel Mini Guide screen from the current 
programme onwards according to the programme starting time order.

Default Guide → Mini Guide / Full Guide
You can decide whether to display either the Mini Guide or the Full Guide when the GUIDE button on the remote control is 
pressed.

Channel List
For detailed procedures on using the Channel List, refer to the Managing Channels instructions.

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode
When press the P >/< button, Channels will be switched within the selected channel list.

Added Ch.
Channels will be switched within the memorized channel list.

Favourite Ch.
Channels will be switched within the favourite channel list.
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Fine Tune
If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 
operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk “*” on the right-hand side of the channel number in the 
channel banner.
To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button.
Only Analogue TV channels can be fine tuned.

Using the Full / Mini Guide

To... Then...
Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.
Exit the guide Press the blue button
If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press 
the ◄, ► button to select Cancel Schedules, the scheduling is cancelled with the clock icon gone. 
View programme information Select a programme of your choice by pressing the ▲, ▼, ◄, ► button. 

Then press the INFO button when the programme of your choice is 
highlighted.
The programme title is on the upper part of the screen centre. 

Please click on INFO button for the detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video 
Quality Information (HD / SD), Sound Modes, Subtitle or Teletext, languages of Subtitle or Teletext and brief summary of the 
highlighted programme are included on the detailed information. “...” will be appeared if the summary is long.
Toggle between the Mini Guide and Full Guide Press the Red button repeatedly.
In Full Guide 
Scrolls backwards quickly (24 hours). 
Scrolls forwards quickly (24 hours).

Press the Green button repeatedly.
Press the Yellow button repeatedly.

In Mini Guide
Display previous page quickly.
Display next page quickly.

Press the Green button.
Press the Yellow button.
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Full Guide

E Watch      Information      Mini Guide      +24 Hours      Exit

DTV Cable 900 f tn                         2:10 Tue 1 Jun
Freshmen On Campus	
2:00 - 2:30
No Detailed Information

Today 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
40 with Dynamite MC
The Distillery
Smash Hits! Sunday

900       f tn
901       ITV Play
902       Kerrang!
903       Kiss
904       oneword
905       Hits▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

  900

E Watch      Information      Full Guide      Next Page      Exit

Mini Guide DTV Cable 900 f tn

Street Hypnosis
Booze Britain

2:00
2:30
5:00

Freshmen On Campus

▼
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Managing Channels 
Using this menu, you can add / delete or set favourites channels and use the programme guide for digital broadcasts.

All Channels
Shows all currently available channels.

Added Channels
Shows all added channels.

Favourites
Shows all favourite channels.

To select the favourites channels you have set up, press the FAV.CH button on the remote 
control.

Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.
Using the Colour buttons with the Channel List

Red (Channel Type): Toggle between your TV, Radio, Data / Other and All.
Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists. You can perform the add/delete or add to favourites/delete from favourites 
function for multiple channels at the same time. Select the required channels and press the Yellow button to set all the 
selected channels at the same time.  The c mark appears to the left of the selected channels.
TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 
Viewing, Edit Channel Name, Edit Channel Number, Sort, Select All, Deselect All or Auto Store menu. (The Options 
menus may differ depending on the situation.)

Channel Status Display Icons
A: An Analogue channel.
c: A channel selected by pressing the Yellow button.
*: A channel set as a Favourite.
(: A programme currently being broadcast.
\: A locked channel.
): A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)
Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel status.

Add / Delete
You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.
A gray-coloured channel indicates the channel has been deleted.
The Add menu only appears for deleted channels.
You can also delete a channel to the Added Channels or Favourites menu in the same 
manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

Press the TOOLS button to display the Tools menu. You can also set the add to (or delete from) Favourite by selecting Tools 
→ Add to Favourite (or Delete from Favourite).
The “*” symbol will be displayed and the channel will be set as a favourite.
All favourite channels will be shown on Favourites menu.

Lock / Unlock
You can lock a channel so that the channel cannot be selected and viewed. 

This function is available only when the Child Lock is set to On. 
The PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is ‘0-0-0-0’. You can change the PIN, by selecting Change PIN from the menu.
The ‘\’ symbol will be displayed and the channel will be locked.
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All Channels

824          UKTV Gold
825          UKTV style

A 1     C --
A 2          C --
A 3          C --
A 4          C --
A 5          C --
A 6          C --
A 7          C --
A 8          C --

            All          Channel Type     Zoom     Select   T Tools

Delete
Add to Favourite
Lock
Timer Viewing
Edit Channel Name
Sort
                                       �

Added Channels

824          UKTV Gold
825          UKTV style

A 1     C --
A 2          C --
A 3          C --
A 4          C --
A 5          C --
A 6          C --
A 7          C --
A 8          C --

            All          Channel Type     Zoom     Select   T Tools
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Timer Viewing
If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 
even when you are watching another channel. To reserve a programme, set the current time first. 

Only memorized channels can be reserved.
You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Reserving a programme will be shown in the Programmed menu.
Digital Programme Guide and Viewing Reservation
When a digital channel is selected, and you press the ► button, the Programme Guide for the channel appears. You can 
reserve a programme according to the procedures described above.

Edit Channel Name (analogue channels only)
Channels can labelled so that their call letters appear whenever the channel is selected.

The names of digital broadcasting channels are automatically assigned and cannot be renamed.

Edit Channel Number (digital channels only)
You can also edit the channel number by pressing the number buttons on the remote control.

Sort (analogue channels only)
This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 
the auto store.

Select All / Deselect All
Select All: You can select all the channels in the channel list.
Deselect All: You can deselect all the selected channels.
You can only select Deselect All when there is a selected channel.

Auto Store
For detailed procedures on setting up options, refer to the ‘Channel Menu’ instructions.
If a channel is locked using the Child Lock function, the PIN input window appears.

Channel List Option Menu (in Programmed)
You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.

Change Info
Select to change a viewing reservation.

Cancel Schedules
Select to cancel a viewin`g reservation.

Information
Select to view a viewing reservation. 
(You can also change the reservation information.)

Select All
Select all reserved programmes.
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Programmed

1 / 1 / 2009

13:59   5  TV1   ) 

18:59     2    TV3    ) The Equalizer
20:59     2    TV3    ) McMillan & Wife
21:59     2    TV3    ) M.Spillane’s mike 

            All         Zoom     Select   T Tools    E Information

Change Info
Cancel Schedules
Information
Select All
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PICTURE

Configuring the Picture Menu

Mode
You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also set the picture mode by 
selecting Tools → Picture Mode.

Dynamic
Selects the picture for increased definition in a bright room.

Standard
Selects the picture for the optimum display in a normal environment.

Natural
Selects the picture for an optimum and eye-comfortable display.

Movie
Selects the picture for viewing movies in a dark room.

Backlight / Contrast / Brightness / Sharpness / Colour / Tint(G/R)
Your television has several setting options that allow you to control the picture quality.

Backlight: Adjusts the brightness of LCD back light.
Contrast: Adjusts the contrast level of the picture.
Brightness: Adjusts the brightness level of the picture
Sharpness: Adjusts the edge definition of the picture.
Colour: Adjusts colour saturation of the picture.
Tint(G/R): Adjusts the colour tint of the picture.
In analogue TV, Ext., AV modes of the PAL system, you cannot use the Tint(G/R) Function.
When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint(G/R) the OSD will be adjusted 
accordingly.
In PC mode, you can only make changes to Backlight, Contrast and Brightness.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
The energy consumed during use can be significantly reduced if the brightness level of the picture is lowered, which will 
reduce the overall running cost.

Advanced Settings
Samsung’s new TVs allow you to make even more precise picture settings than previous 
models. 

Advanced Settings is available in Standard or Movie mode.
In PC mode, you can only make changes to Dynamic Contrast, Gamma and White 
Balance from among the Advanced Settings items.

Black Tone → Off / Dark / Darker / Darkest
You can select the black level on the screen to adjust the screen depth.

Dynamic Contrast → Off / Low / Medium / High
You can adjust the screen contrast so that the optimal contrast is provided.

Gamma
You can adjust the primary colour (red, green, blue) intensity.
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Mode	 : Standard	 ▶

Backlight	 : 7
Contrast	 : 95
Brightness	 : 45
Sharpness	 : 50
Colour	 : 50
Tint (G/R)	 : G50/R50
Advanced Settings

Picture

7

 U Move    L Adjust     E Enter     R Return

      ▲
Backlight
      ▼

Black Tone	 : Off	 	 ▶
Dynamic Contrast	 : Medium
Gamma	 : 0
Colour Space	 : Native
White Balance
Flesh Tone	 : 0
Edge Enhancement	 : On

U Move     E Enter     R Return

Advanced Settings
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Colour Space
Colour space is a colour matrix composed of red, green and blue colours. Select your favourites colour space to experience the 
most natural colour.

Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on program sources.
Native: Native Colour Space offers deep and rich colour tone.
Custom: Adjusts the colour range to suit your preference.

Changing the adjustment value will refresh the adjusted screen.
Settings can be adjusted and stored for each external device you have connected to an input of the TV. For example, if 
you have a DVD player connected to HDMI 1 and it is currently selected, settings and adjustments will be saved for the 
DVD player. 

Colour: Red, Green, Blue, Yellow, Cyan or Magenta
Colour is available when Colour Space is set to Custom.
In Colour, you can adjust the RGB values for the selected colour.
To reset the adjusted RGB value, select Reset.

Red: Adjusts the red saturation level of the selected colour.
Green: Adjusts the green saturation level of the selected colour.
Blue: Adjusts the blue saturation level of the selected colour.
Reset: Resets the colour space to the default values.

White Balance
You can adjust the colour temperature for more natural picture colours.

R-Offset: Adjusts the red colour darkness.
G-Offset: Adjusts the green colour darkness.
B-Offset: Adjusts the blue colour darkness.
R-Gain: Adjusts the red colour brightness.
G-Gain: Adjusts the green colour brightness.
B-Gain: Adjusts the blue colour brightness.
Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone
You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.

Edge Enhancement → Off / On
You can emphasize object boundaries in the picture.
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Picture Options
In PC mode, you can only make changes to the Colour Tone and Size from among the 
items in Picture Options.

Colour Tone → Cool / Normal / Warm1 / Warm2 / Warm3
Warm1, Warm2 or Warm3 is only activated when the picture mode is Movie.
Settings can be adjusted and stored for each external device you have connected to an 
input of the TV.

Size
Occasionally, you may want to change the size of the image on your screen. Your TV comes 
with several screen size options, each designed to work best with specific types of video input. Your cable box/satellite receiver 
may have its own set of screen sizes as well. In general, though, you should view the TV in 16:9 mode as much as possible.

You can select these options by simply pressing the P.SIZE button on the remote control.
Auto Wide: Automatically adjusts the picture size to the 16:9 aspect ratio.
16:9: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.
4:3: This is the default setting for a video movie or normal broadcasting.
Screen Fit: Use the function to see the full image without any cut-off when HDMI (720p / 1080i / 1080p) or Component (1080i 
/ 1080p) signals are input.
Depending on the input source, the picture size options may vary.
The items available may differ depending on the selected mode.
In PC Mode, only 16:9 and 4:3 mode can be adjusted.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Temporary image retention may occur when viewing a static image on the set for more than two hours.
Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
picture up / down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the picture 
up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE button. Press 
the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE button.
After selecting Screen Fit in HDMI (1080i / 1080p) or Component (1080i / 1080p) mode: Select Position by pressing the ◄ 
or ► button. Use the ▲, ▼, ◄ or ► button to move the picture.

Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.
If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the Overscan 
function.

Screen Mode → 16:9 / Wide Zoom / Zoom / 4:3
When setting the picture size to Auto Wide in a 16:9 wide TV, you can determine the picture size you want to see the 4:3 WSS 
(Wide Screen Service) image or nothing. Each individual European country requires different picture size so this function is 
intended for users to select it.

16:9: Sets the picture to 16:9 wide mode.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnify the size of the picture vertically on screen.
4:3: Sets the picture to 4:3 normal mode.
This function is available in Auto Wide mode.
This function is not available in PC, Component or HDMI mode.

Digital NR → Off / Low / Medium / High / Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 
and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.

HDMI Black Level → Normal / Low
You can select the black level on the screen to adjust the screen depth.

This function is active only when an external device is connected to the TV via HDMI (RGB signals).
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Film Mode	 : Off
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Picture Options
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Film Mode → Off / Auto1 / Auto2
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV, COMPONENT(480i / 1080i) and HDMI(480i / 1080i).
Off: Turn the Film Mode function off.
Auto1: Automatically adjusts the picture for the best quality when watching a film.
Auto2: Automatically optimizes the video text on the screen (not including closed captions) when watching a film.

Blue Only Mode → Off / On
This function is for AV device measurement experts. This function displays the blue signal only by removing the red and green 
signals from the video signal so as to provide a Blue Filter effect that is used to adjust the Colour and Tint of video equipment such 
as DVD players, Home Theatres, etc. Using this function, you can adjust the Colour and Tint to preferred values appropriate to 
the signal level of each video device using the Red / Green / Blue / Cyan / Magenta / Yellow Colour Bar Patterns, without using an 
additional Blue Filter.

Blue Only Mode is available when the picture mode is set to Movie or Standard.

Picture Reset → Reset Picture Mode / Cancel
Resets all picture settings to the default values.

Reset Picture Mode: Current picture values return to default settings.
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Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)
The Windows display-settings for a typical computer are shown below. The actual screens on 
your PC will probably be different, depending upon your particular version of Windows and 
your particular video card. However, even if your actual screens look different, the same basic 
set-up information will apply in almost all cases. (If not, contact your computer manufacturer or 
Samsung Dealer.)
1.	 First, click on ‘Control Panel’ on the Windows start menu.
2.	 When the control panel window appears, click on ‘Appearance and Themes’ and a display 

dialog-box will appear.
3.	 When the control panel window appears, click on ‘Display’ and a display dialogbox will 

appear.
4.	 Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution) - Optimum: 1920 X 1080 pixels
If a vertical-frequency option exists on your display settings dialog box, the correct 
value is ‘60’ or ‘60 Hz’. Otherwise, just click ‘OK’ and exit the dialog box.

Display Modes
If the signal from the system equals the standard signal mode, the screen is adjusted automatically. If the signal from the system 
doesn’t equal the standard signal mode, adjust the mode by referring to your videocard user guide; otherwise there may be no 
video. For the display modes listed on the next page, the screen image has been optimized during manufacturing.

D-Sub and HDMI/DVI Input
Mode Resolution Horizontal Frequency 

(KHz)
Vertical Frequency 

(Hz)
Pixel Clock Frequency 

(MHz)
Sync Polarity 

(H / V)
IBM  640 x 350 31.469 70.086 25.175 +/-

 720 x 400 31.469 70.087 28.322 -/+

MAC
 640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-
1152 x 870 68.681 75.062 100.000 -/-

VESA CVT

720 x 576 35.910 59.950 32.750 -/+
1152 x 864 53.783 59.959 81.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 720 56.456 74.777 95.750 -/+
1280 x 960 75.231 74.857 130.000 -/+

VESA DMT

640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.861 72.809 31.500 -/-
640 x 480 37.500 75.000 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 48.077 72.188 50.000 +/+
800 x 600 46.875 75.000 49.500 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1152 x 864 67.500 75.000 108.000 +/+

1280 x 1024 63.981 60.020 108.000 +/+
1280 x 1024 79.976 75.025 135.000 +/+
1280 x 800 49.702 59.810 83.500 -/+ 
1280 x 800 62.795 74.934 106.500 -/+ 
1280 x 960 60.000 60.000 108.000 +/+
1360 x 768 47.712 60.015 85.500 +/+
1440 x 900 55.935 59.887 106.500 -/+ 
1440 x 900 70.635 74.984 136.750 -/+
1680 x 1050 65.290 59.954 146.250 -/+ 

VESA GTF 1280 x 720 52.500 70.000 89.040 -/+ 
1280 x 1024 74.620 70.000 128.943 -/-

VESA DMT / 
DTV CEA 1920 x 1080p 67.500 60.000 148.500 +/+

When using an HDMI / DVI cable connection, you must use the HDMI IN 3(DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.
Too long or low quality VGA cable can cause picture noise at high resolution modes (1920x1080).
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Setting up the TV with your PC
Preset: Press the SOURCE button to select PC mode.

Auto Adjustment
Use the Auto Adjust function to have the TV automatically adjust the video signals it receives.
The function also automatically fine-tunes the settings and adjusts the frequency values and 
positions.

Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 
by selecting Tools → Auto Adjustment.
This function does not work in DVI-HDMI mode.

Screen

Coarse / Fine
The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is 
not removed by Fine-tuning alone, then adjust the frequency as best as possible (Coarse) and 
Fine-tune again. After the noise has been reduced, readjust the picture so that it is aligned on 
the centre of screen.

PC Position
Adjust the PC’s screen positioning if it does not fit the TV screen. 
Press the ▲ or ▼ button to adjusting the Vertical-Position. Press the ◄ or ► button to adjust 
the Horizontal-Position.

Image Reset
You can replace all image settings with the factory default values.
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Brightness	 : 45
Sharpness	 : 50

Auto Adjustment	 	 ▶

Screen
Advanced Settings
Picture Options
Picture Reset

Picture

Coarse	 	 	 50
Fine	 	 	 0
PC Position
Image Reset
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SOUND

Configuring the Sound Menu

Mode → Standard / Music / Movie / Clear Voice / Custom
Press the TOOLS button to display the Tools menu. You can also set the sound mode by 
selecting Tools → Sound Mode.
Standard: Selects the normal sound mode.
Music: Emphasizes music over voices.
Movie: Provides the best sound for movies.
Clear Voice: Emphasizes voice over other sounds.
Custom: Recalls your customized sound settings.

Equalizer
The sound settings can be adjusted to suit your personal preferences.

Mode: Selects the sound mode among the predefined settings.
Balance L/R: Adjusts the balance between the right and left speaker.
100Hz / 300Hz / 1KHz / 3KHz / 10KHz (Bandwidth Adjustment): To adjust the level of different bandwidth frequencies.
Reset: Resets the equalizer settings to the default values.

SRS TruSurround HD → Off / On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 
speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 
including internal television speakers. It is fully compatible with all multichannel formats.

Press the TOOLS button to display the Tools menu. You can also set the SRS TruSurround HD by selecting Tools → SRS TS 
HD.

Audio Language
You can change the default value for audio languages. Displays the language information for the incoming stream.

While viewing a digital channel, this function can be selected.
You can only select the language among the actual languages being broadcast.

Audio Format → MPEG / Dolby Digital
When sound is emitted from both the main speaker and the audio receiver, a sound echo may occur due to the decoding speed 
difference between the main speaker and the audio receiver. In this case, use the TV Speaker function.

While viewing a digital channel, this function can be selected.
The Audio Format appears according to the broadcasting signal.

Audio Description
This is an auxiliary audio function that provides an additional audio track for visually challenged persons. This function handles the 
Audio Stream for the AD (Audio Description), when it is sent along with the Main audio from the broadcaster. Users can turn the 
Audio Description On or Off and control the volume.

Audio Description → Off / On
Turn the audio description function on or off.

Volume
You can adjust the audio description volume.

Volume is active when Audio Description is set to On.
While viewing a Digital channel, this function can be selected.

Auto Volume → Off / On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 
changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 
modulation signal is high or by raising the sound output when the modulation signal is low.
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Mode	 : Custom	 ▶

Equalizer
SRS TruSurround HD	 : Off
Audio Language	 : ----
Audio Format	 : ----
Audio Description
Auto Volume	 : Off
Speaker Select	 : TV Speaker

Sound
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Speaker Select
When you watch TV with it connecting to a Home theatre, turn the TV speakers off so you can listen to sound from the Home 
theatre’s (external) speakers.

External Speaker: Used to listen to the sound of the External (Home Theatre) Speakers.
TV Speaker: Used to listen to the sound of the TV Speakers.
The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.
If you select External Speaker in the Speaker Select menu, the sound settings will be limited

TV’s Internal Speakers Audio Out (Optical, L/R Out) to Sound System
RF / AV / Component / PC / HDMI RF / AV / Component / PC / HDMI

TV Speaker Speaker Output Sound Output
External Speaker Mute Sound Output
Video No Signal Mute Mute

Sound Reset → Reset All / Reset Sound Mode / Cancel
You can restore the Sound settings to the factory defaults.

Reset Sound Mode: Current sound values return to default settings.

Selecting the Sound Mode
You can set the sound mode in the Tools menu. When you set to Dual l ll, the current sound mode is displayed on the screen.

Audio Type Dual 1 / 2 Default

A2 Stereo
Mono MONO

Automatic change
Stereo STEREO ↔ MONO
Dual DUAL 1 ↔ DUAL 2 DUAL 1

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO ↔ STEREO

Dual MONO ↔ DUAL 1 
DUAL 2 DUAL 1

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound signal.
This function is only available in TV mode.
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SETUP

Configuring the Setup Menu

Language
You can set the menu language.

Time
For detailed procedures on setting up options, refer to the ‘Setting the Time’ instructions.

Game Mode → Off / On 
When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more 
realistic gaming experience by selecting game menu.

Restrictions on game mode (Caution)
To disconnect the game console and connect another external device, set Game Mode to Off in the setup menu.
If you display the TV menu in Game Mode, the screen shakes slightly.

Game Mode is not available in regular TV, PC and Ext mode.
If the picture is poor when external device is connected to TV, check if Game Mode is On. Set Game Mode to Off and 
connect external devices.
If Game Mode is On:

Picture mode is automatically changed to Standard and cannot be changed.
Sound mode is automatically changed to Custom and cannot be changed. Adjust the sound using the equalizer.
The Reset Sound function is activated. Selecting the Reset function after setting the equalizer resets the equalizer 
settings to the factory defaults.

Child Lock → Off / On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 
and audio.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0. You can change the PIN by selecting Change PIN from the menu.
You can lock some channels in Channel List.
Child Lock is available only in TV mode.

Change PIN
You can change your personal ID number that is required to set up the TV.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is 0-0-0-0.
If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to 0-0-0-0: 
POWER (Off) → MUTE → 8 → 2 → 4 → POWER (On).

Parental Lock → Parental Rating
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by a 4-digit PIN 
(Personal Identification Number) code that is defined by the user.

The Parental Rating item differs depending on the country.
Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is ‘0-0-0-0’. You can change the PIN by selecting Change PIN from the menu.
When the parental ratings are set, the ‘\’ symbol is displayed.
Allow All: Press to unlock all TV ratings.
Block All: Press to lock all TV ratings.
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Subtitle
You can activate and deactivate the subtitles. Use this menu to set the Subtitle Mode. Normal under the menu is the basic subtitle 
and Hard of hearing is the subtitle for a hearing-impaired person.

Subtitle → Off / On
Switches subtitles on or off.

Mode → Normal / Hard of hearing
Sets the subtitle mode.

Subtitle Language
Set the subtitle language.

If the programme you are watching does not support the Hard of hearing function, Normal automatically activates even 
though Hard of hearing mode is selected.
English is the default in cases where the selected language is unavailable in the broadcast.
You can select these options simply by pressing the SUBT. button on the remote control.

Teletext Language
You can set the Teletext language by selecting the language type.

English is the default in cases where the selected language is unavailable in the broadcast.

Preference

Primary Audio Language / Secondary Audio Language / Primary Subtitle Language / Secondary Subtitle Language / 
Primary Teletext Language / Secondary Teletext Language
Using this feature, users can select one of the languages. The language selected here is the default when the user selects a 
channel.
If you change the language setting, the Subtitle Language, Audio Language, and the Teletext Language of the Language menu are 
automatically changed to the selected language.
The Subtitle Language, Audio Language, and the Teletext Language of the Language menu show a list of languages supported 
by the current channel and the selection is highlighted. If you change this language setting, the new selection is only valid for the 
current channel. The changed setting does not change the setting of the Primary Subtitle Language, Primary Audio Language, or 
the Primary Teletext Language of the Preference menu.

Digital Text → Disable / Enable (UK only)
If the programme is broadcast with digital text, this feature is enabled.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
An International standard for data encoding systems used in multimedia and hypermedia. This is at a higher level than the 
MPEG system which includes data-linking hypermedia such as still images, character service, animation, graphic and video 
files as well as multimedia data. MHEG is user runtime interaction technology and is being applied to various fields including 
VOD (Video-On-Demand), ITV (Interactive TV), EC (Electronic Commerce), tele-education, tele-conferencing, digital libraries 
and network games.

Melody → Off / Low / Medium / High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play
When no sound is output from the TV because the MUTE button has been pressed.
When no sound is output from the TV because the volume has been reduced to minimum with the volum (-) button.
When the TV is turned off by Sleep Timer function.

Energy Saving → Off / Low / Medium / High / Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 
Saving mode option to High to reduce eye fatigue as well as power consumption.

Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools → Energy 
Saving.
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Common Interface

CI Menu
This enables the user to select from the CAM-provided menu.
Select the CI Menu based on the menu PC Card.

Application Info.
This contains information on CAM inserted in the CI slot and displays it. The Application Info inserting is about the CI CARD. You 
can install the CAM anytime whether the TV is ON or OFF.
1.	 Purchase the CI CAM module by visiting your nearest dealer or by phone.
2.	 Insert the CI CARD into the CAM in the direction of the arrow until it fits.
3.	 Insert the CAM with the CI CARD installed into the common interface slot. 

(Insert the CAM in the direction of the arrow, right up to the end so that it is parallel with the slot.)
4.	 Check if you can see a picture on a scrambled signal channel.

❑

■

■

Setting the Time

Clock
Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.
If you disconnect the power cord, you have to set the clock again.

Clock Mode
You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time from the digital broadcast.
Manual: Set the current time to a manually specified time.
Depending on the broadcast station and signal, the auto time may not be set correctly. If 
this occurs, set the time manually.
The Antenna or cable must be connected in order to set the time automatically.

Clock Set
You can set the current time manually.

This function is only available when Clock Mode is set to Manual.
You can set the day, month, year, hour and minute directly by pressing the number buttons on the remote control.

Sleep Timer
The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 minutes).

Press the TOOLS button to display the Tools menu. You can also set the sleep timer by selecting Tools → Sleep Timer.
To cancel the Sleep Timer function, select Off.

Timer 1 / Timer 2 / Timer 3
Three different on / off timer settings can be made.
You must set the clock first.

On Time
Set the hour, minute, and activate / inactivate.
(To activate timer with the setting you’ve chosen, set to Activate.)

Off Time
Set the hour, minute, and activate / inactivate.
(To activate timer with the setting you’ve chosen, set to Activate.)
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Volume
Set the desired volume level.

Source → TV / USB
You can select the TV or USB device content to be played when the TV turns on automatically. Select TV or USB. (Make sure that 
an USB device is connected to your TV.)

When there is only one photo file in the USB, the Slide Show will not play.

Antenna (when Source is set to TV)
Select ATV or DTV.

Channel (when Source is set to TV)
Select the desired channel.

Contents (when Source is set to USB)
You can select a folder on the USB Device with music or photo files to be played when the TV turns on automatically.

If the folder name is too long, the folder can not be selected.
If the folder name to be configured by the Contents function is too long, it cannot be selected.

Repeat
Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun or Manual.

When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 
desired day and the c mark will appear.
You can set the hour, minute and channel by pressing the number buttons on the remote control.
Auto Power Off
When you set the timer on, the television will eventually turn off, if no controls are operated for 3 hours after the TV was turned 
on by the timer. This function is only available in timer on mode and prevents overheating, which may occur if a TV is on for 
too long time.
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INPUT / SUPPORT

Input Menu

Source List
Use to select TV or other external input sources such as DVD / Blu-ray players / Cable Box /
Satellite receivers (Set-Top Box) connected to the TV. Use to select the input source of your 
choice.

Press the SOURCE button on the remote control to view an external signal source. TV 
mode can be selected by pressing the TV button, number buttons (0~9), and the P < / > 
button on the remote control.

TV / Ext.1 / Ext.2 / AV / Component / PC / HDMI1 / HDMI2 / HDMI3/DVI / HDMI4
You can choose only those external devices that are connected to the TV. In the Source 
List, connected inputs will be highlighted and sorted to the top. Inputs that are not connected 
will be sorted to the bottom.
Using the Colour buttons on the remote with the Source list

Red (Refresh): Refreshes the connected external devices. Press this if your Source is 
on and connected, but does not appear in the list.
TOOLS (Tools): Displays the Edit Name and Information menus.

Edit Name

VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI / DVI PC / TV / IPTV / Blu-ray 
/ HD DVD / DMA
Name the device connected to the input jacks to make your input source selection easier.

When a PC with a resolution of 1920 x 1080@60Hz is connected to the HDMI IN 3 port, you should set the HDMI3/DVI mode 
to DVI PC in the Edit Name of the Input mode.

Support Menu

Self Diagnosis

Picture Test
If you think you have a picture problem, perform the picture test. Check the colour pattern on 
the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 
There may be a problem with the TV. Therefore, contact Samsung’s call centre for 
assistance.
No: If the test pattern is properly displayed, select No. There may be a problem with your 
external equipment. Please check your connections. If the problem still persists, refer to the 
external device’s user manual.

Sound Test
If you think you have a sound problem, please perform the sound test. You can check the sound 
by playing a built-in melody sound through the TV.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure 
Speaker Select is set to TV speaker in the Sound menu.
The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 
the MUTE button.
Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 
the TV. Therefore, contact Samsung’s call centre for assistance.
No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual.
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Signal Information (digital channels only)
Unlike analogue channels, which can vary in reception quality from ‘snowy’ to clear, digital (HDTV) channels have either perfect 
reception quality or you will not receive them at all. So, unlike analogue channels, you cannot fine tune a digital channel. You can, 
however, adjust your antenna to improve the reception of available digital channels.

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to increase the signal strength. 
Continue to adjust the antenna until you find the best position with the strongest signal.

Software Upgrade
Samsung may offer upgrades for the TV’s firmware in the future. These upgrades can be 
performed via the TV when it is connected to the Internet, or by downloading the new firmware 
from samsung.com to a USB memory device.

Current Version is the software already installed in the TV.
Alternative Software (Backup) shows the previous version that will be replaced.
Software is represented as ‘Year/Month/Day_Version’. The more recent the date, the newer 
the software version. Installing the latest version is recommended.

By USB
Insert a USB drive containing the firmware upgrade downloaded from samsung.com into the 
TV. Please be careful to not disconnect the power or remove the USB drive while upgrades 
are being applied. The TV will turn off and turn on automatically after completing the firmware 
upgrade. Please check the firmware version after the upgrades are complete (the new version 
will have a higher number than the older version).
When software is upgraded, video and audio settings you have made will return to their default 
(factory) settings. We recommend you write down your settings so that you can easily reset 
them after the upgrade.

By Channel
Upgrades the software using the broadcasting signal.

Standby Mode Upgrade
To continue software upgrade with master power on, Select On by pressing the ▲ or ▼ button. 45 minutes after entering standby 
mode, a manual upgrade is automatically conducted. Since the power of the unit is turned on internally, the screen may be on 
slightly for the LCD product. This phenomenon may continue for more than 1 hour until the software upgrade is completed.

Alternative Software (Backup)
If there is an issue with the new firmware and it is affecting operation, you can change the software to the previous version.

If software was changed, existing software is displayed.
You can change current software to alternative software by ‘Alternative Software’.

HD Connection Guide
This menu presents the connection method that provides the optimal quality for the HD TV. Refer to this information when 
connecting external devices to the TV.

Contact Samsung
View this information when your TV does not work properly or when you want to upgrade the software. You can view the 
information regarding the call centre, product and software file download method.
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Media Play (USB)

Connecting a USB Device

1.	 Press the POWER button to turn the TV on.
2.	 Connect a USB device containing photo and/or music files to the USB jack on the side of the 

TV.
3.	 When the Application selection screen is displayed, press the ENTERE button to select 

Media Play (USB).
MTP (Media Transfer Protocol) is not supported.
The file system supports FAT16, FAT32 and NTFS.
Certain types of USB Digital camera and audio devices may not be compatible with this 
TV.
Media Play only supports USB Mass Storage Class devices (MSC). MSC 
is a Mass Storage Class Bulk-Only Transport device. Examples of MSC 
are Thumb drives, Flash Card Readers and USB HDD (USB HUB are not 
supported.). 
Please connect directly to the USB port of your TV. If you are using a separate 
cable connection, there may be a USB compatibility problem.
Before connecting your device to the TV, please back up your files to prevent 
them from damage or loss of data. SAMSUNG is not responsible for any data 
file damage or data loss.
Do not disconnect the USB device while it is loading.
MSC supports MP3 and JPEG files, while a PTP device supports JPEG files only.
The higher the resolution of the image, the longer it takes to display on the screen.
The maximum supported JPEG resolution is 15360X8640 pixels.
For unsupported or corrupted files, the ‘Not Supported File Format’ message is displayed.
MP3 files with DRM that have been downloaded from a non-free site cannot be played. Digital Rights Management (DRM) 
is a technology that supports the creation of content, the distribution and management of the content in an integrated 
and comprehensive way, including the protection of the rights and interests of the content providers, the prevention of the 
illegal copying of contents, as well as managing billings and settlements.
When moving to a photo, loading may take a few seconds. At this point, the loading icon will appear at the screen. 
If more than one MSC device is connected, some of them may not be recognized. If a device requires high power (more 
than 500mA or 5V), the USB device may not be supported. 
If an over-power warning message is displayed while you are connecting or using a USB device, the device may not be 
recognized or may malfunction.

Using the Remote Control Button in Media Play Menu
Button Operations

▲/▼/◄/► Move the cursor and select an item.

ENTERE
Select the currently selected item. While playing a slide show or music file:
- Pressing the ENTERE button during play pauses the play.
- Pressing the ENTERE button during pause resumes the play.

∂/∑ Play or pause the Slide Show, music.
RETURN Return to the previous menu.
TOOLS Run various functions from the Photo and Music menus.

∫ Stop the current slide show or Music file.
π/μ Jump to previous group/Jump to next group.

INFO Show file information.
MEDIA.P Exit Media Play mode.

< P >, EXIT, TV Stop Media Play mode and Returns to TV mode.
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Media Play Function
This function enables you to view and listen to photo and/or music files saved on a USB Mass Storage Class (MSC) device.

Entering the Media Play (USB) Menu
1.	 Press the MENU button. Press the ▲ or ▼ button to select Application, then 

press the ENTERE button.

2.	 Press the ▲ or ▼ button to select Media Play (USB), then press the ENTERE 
button.

The Media Play (USB) menu is displayed.

Press the MEDIA.P button on the remote control to display the Media Play 
menu.

Press the SOURCE button on the remote control to view the source list. 
Then Press the ▲ or ▼ button to select USB.

3.	 Press the Red button, then press the ▲ or ▼ button to select the USB Memory. 
Press the ENTERE button.

This function differs depending on the USB Memory.
The selected USB device name appears at the bottom left of the screen.

4.	 Press the ◄ or ► button to select an icon (Photo, Music, Setup), then press the 
ENTERE button. 
To exit Media Play mode, press the MEDIA.P button on the remote control.

Removing a USB Memory Device Safely
You can remove the device safely from the TV.
1.	 Press the TOOLS button in the Media Play file list screen, or while a Slide Show or music is being played.
2.	 Press the ▲ or ▼ button to select Remove Safely, then press the ENTERE button.
3.	 Remove the USB device from the TV.

Screen Display

Move to either ‘Group List Section’ or ‘File List Section’ using the Up and Down buttons. After selecting a section, press the ◄ or ► 
buttons to select an item.
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1	 View Groups: The sort group where the currently selected file is contained is highlighted.
2	 Currently selected file: The selected file is the file you can now control. Photo file are displayed as thumbnail images.
3	 Current Device: Shows the currently selected device name. Press the Red button to select a device.

Red (Device) button: Selects a connected device.
4	 Item Selection Information: Shows the number of files that are selected by pressing the Yellow button.
5	 Help Items

Yellow (Select) button: Selects file from the file list. Selected files are marked with a symbol c. Press the Yellow button 
again to cancel a file selection.
TOOLS (Tools) button: Displays the option menus. (The option menu changes according to the current status.)

Photo List Option Menu

1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Photo, then press the ENTERE button. 
3.	 Press the ▼ button to move to the File List Section.
4.	 Press the ◄ or ► button to select the desired photo file.

Selecting Multiple Photos
Press the ◄ or ► button to select the desired photo file. Then press the 
Yellow button.
Repeat the above operation to select multiple photo files.
The mark c appears to the selected photo file.

5.	 Press the TOOLS button.
The option menu changes according to the current status.

Slide Show
Using this menu, you can play a SlideShow using the photo files on the USB memory device.

Play Current Group
Using this menu, you can play a SlideShow using only the photo files in the currently selected sorting group.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The photo file information including the name, the size, the resolution, the date modified and the path is displayed.

You can view the information of photo files during a SlideShow using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Viewing a Photo or Slide Show

Viewing a Slide Show
1.	 Press the ▼ button to select the File List Section.

2.	 Press the TOOLS button.

3.	 Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.
All files in the photo list will be used for the Slide Show.

During the slide show, files are displayed in order from the currently shown file.
The Slide Show progresses in the order sorted in the Photo list.

Music files can be automatically played during the Slide Show if the Background 
Music is set to On. 

While a photo list is displayed, press the ∂(Play)/ENTERE button on the 
remote control to start slide show.

SlideShow Control Buttons
Button Operations

ENTERE Play/Pause the Slide Show.
∂ Play the Slide Show.
∑ Pause the Slide Show.
∫ Exit Slide Show and return to the photo list.

π/μ Change the SlideShow playing speed.
TOOLS Run various functions from the Photo menus.

Playing current group
1.	 Press the ▲ button to move to the Group List Section.
2.	 Select a group using the ◄ and ► buttons. 
3.	 Press the ∂ (Play) button. A slideshow begins with the files of the selected 

group.

Alternatively 
1.	 Select the files In the File List Section, contained the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) 
button.

2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

Only the photos in the sorting group including the selected files will be used for the Slide Show.

To perform a Slide Show with only the selected files
1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select the desired photo in the Photo list.
3.	 Press the Yellow button.
4.	 Repeat the above operation to select multiple photos.

The c mark appears to the left of the selected photo.
If you select one file, the Slide Show will not be performed.
To deselect all selected files, press the TOOLS button and select Deselect All.

5.	 Press the ∂ (Play)/ENTERE button.
The selected files will be used for the Slide Show.
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Alternatively 
1.	 In the Photo List, press the Yellow buttons to select the desired photos.
2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Slide Show, then press the ENTERE button.

The selected files will be used for the Slide Show.

Slide Show Option Menu

1.	 During a slide show (or when viewing a photo), press the TOOLS button to set the 
option.

2.	 Press the ▲ or ▼ button to select the desired option, then press the ENTERE 
button.

Stop Slide Show / Start Slide Show
You can start or stop a SlideShow.

Slide Show Speed → Slow / Normal / Fast
You can select the slide show speed.

This function is available only during a slide show.
You can also change the speed of the Slide Show by pressing the π (REW) or μ (FF) button during the Slide Show.

Rotate
You can rotate photos saved on a USB memory device.

Whenever you press the ◄ button, it rotates by 270˚, 180˚, 90˚, and 0˚.
Whenever you press the ► button, it rotates by 90˚, 180˚, 270˚, and 0˚. 
The rotated file is not saved.

Zoom
You can magnify photos saved on a USB memory device. (x1 → x2 → x4)

To move the enlarged photo image, press the ENTERE button, then press the ▲/▼/◄/► buttons. Note that when the 
enlarged picture is smaller than the original screen size, the location change function doesn’t work.
The enlarged file is not saved.

Background Music
You can select background music when watching a Slide Show.

To use this feature, there must be music and photo files stored on the USB device.

Background Music → Off / On 
Off: Background music is not played.
On: When the background music is available, if you select On, the music is played back. 

Select Music File (0 File(s) Selected)
Only the selected music file is set as the background music.

Picture Setting / Sound Setting
You can select the picture and sound settings.

Information
The photo file information is displayed.

Remove Safely
You can remove the device safely from the TV.
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Picture Setting
Sound Setting
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Remove Safely
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Music List Option Menu

1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Music, then press the ENTERE button. 
3.	 Press the ▲ button to move to the File List Section.
4.	 Press the ◄ or ► button to select the desired Music file. 

Selecting Multiple Music Files
Press the ◄ or ► button to select the desired music file. Then press the 
Yellow button.
Repeat the above operation to select multiple music files.
The mark c appears to the selected music file.

5. 	 Press the TOOLS button.
The option menu changes according to the current status.

Play Current Group
Using this menu, you can only play music files in the currently selected sorting group.

Deselect All (When at least one file is selected)
You can deselect all files.

The c mark indicating the corresponding file is selected is hidden.

Information
The music file information including the name, the size, the date modified and the path is displayed.

You can view the music file information during Play Current Group using the same procedures.
Press the INFO button to viewing the information. 

Remove Safely
You can remove the device safely from the TV.
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Playing a Music

Playing a music file
1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select a music file to be played.
3.	 Press the ∂ (Play)/ENTERE button.

This menu only shows files with the MP3 file extension. Files with other 
file extensions are not displayed, even if they are saved on the same USB 
device.
The selected file is displayed at the top with its playing time.
To adjust the music volume, press the volume button on the remote control. 
To mute the sound, press the MUTE button on the remote control.
If the sound is odd when playing MP3 files, adjust the Equalizer and SRS TruSurround HD in the Sound menu. (An 
over-modulated MP3 file may cause a sound problem.)
The playing duration of a music file may be displayed as ‘00:00:00’ if its playing time information is not found at the start of 
the file.
π (REW) or μ (FF) buttons do not function during play.

Music Play Control Buttons
Button Operations

ENTERE Play/Pause the music file.
∂ Play the music file
∑ Pause the music file
∫ Exit play mode and return to the music list.

TOOLS Run various functions from the Music menus.

Music function information icon

p When all music files in the folder (or the selected file) are repeated. Repeat Mode is On.
q When all music files in the folder (or the selected file) are played once. Repeat Mode is Off.

Playing the music group
1.	 Press the ▲ button to move to the Group List Section.
2.	 Select a group using the ◄ and ► buttons.
3.	 Press the ∂ (Play) button. The files of the selected group will start playing.

Alternatively 
1.	 Select the files In the File List Section, contained the desired group.

To move to the previous/next group, press the π (REW) or µ (FF) button.
2.	 Press the TOOLS button. 
3.	 Press the ▲ or ▼ button to select Play Current Group, then press the ENTERE button.

The music files in the sorting group including the selected file are played.

Playing the selected music files
1.	 Press the ▼ button to select the File List Section.
2.	 Press the ◄ or ► button to select the desired music file.
3.	 Repeat the above operation to select multiple music files.

The c appears to the left of the selected music file.
To deselect all selected files, press the TOOLS button and select Deselect All.

4.	 Press the ∂ (Play)/ENTERE button.
The selected files will be played.
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Music Play option Menu

Music Play Option Menu

Repeat Mode → On / Off
You can play music files repeatedly.

Picture Setting / Sound Setting
You can configure the picture and sound settings.

Information
The music file information is displayed.

Remove Safely
You can remove the device safely from the TV.

¦
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Using the Setup Menu
Setup displays the user settings of the Media Play menu.
1.	 Press the MEDIA.P button.
2.	 Press the ◄ or ► button to select Setup, then press the ENTERE button.
3.	 Press the ▲ or ▼ button to select the desired option.
4.	 Press the ◄ or ► button to select the option, then press the ENTERE button.

To exit Media Play mode, press the MEDIA.P button on the remote control.

Music Repeat Mode → On / Off
Select to repeatedly play music files.

Screen Saver Run Time → 2 hours / 4 hours / 8 hours
Select to set the waiting time before the screen saver appears.

Information
Select to viewing the information of the connected device.

Remove Safely
You can remove the device safely from the TV.
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ANYNET+

Connecting Anynet+ Devices

What is Anynet+?
Anynet+ is a function that enables you to control all connected Samsung devices that support Anynet+ with your Samsung TV’s 
remote. The Anynet+ system can be used only with Samsung devices that have the Anynet+ feature. To be sure your Samsung 
device has this feature, check if there is an Anynet+ logo on it.

To connect to a TV

1.	 Connect the HDMI IN (1, 2, 3(DVI) or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

To connect to Home Theatre

1.	 Connect the HDMI IN (1, 2, 3(DVI) or 4) jack on the TV and the HDMI OUT jack of the corresponding Anynet+ device using an 
HDMI cable.

2.	 Connect the HDMI IN jack of the home theatre and the HDMI OUT jack of the corresponding Anynet+ device using an HDMI 
cable.

Connect the Optical cable between the DIGITAL AUDIO OUT (OPTICAL) jack on your TV and the Digital Audio Input on 
the Home Theatre.
When following the connection above, the Optical jack only outputs 2 channel audio. You will only hear sound from the 
Home Theatre’s Front Left and Right speakers and the subwoofer. If you want to hear 5.1 channel audio, connect the 
DIGITAL AUDIO OUT (OPTICAL) jack on the DVD / Satellite Box (ie Anynet Device 1 or 2) directly to the Amplifier or 
Home Theatre, not the TV.
Connect only one Home Theatre.
You can connect an Anynet+ device using the HDMI 1.3 cable. Some HDMI cables may not support Anynet+ functions.
Anynet+ works when the AV device supporting Anynet+ is in the Standby or On status.
Anynet+ supports up to 12 AV devices in total. Note that you can connect up to 3 devices of the same type.
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Setting Up Anynet+

Press the TOOLS button to display the Tools menu. You can also display Anynet+ menu by 
selecting Tools → Anynet+ (HDMI-CEC).

Setup

Anynet+ (HDMI-CEC) → Off / On
To use the Anynet+ Function, Anynet+ (HDMI-CEC) must be set to On.

When the Anynet+ (HDMI-CEC) function is disabled, all the Anynet+ related operations are 
deactivated.

Auto Turn Off → No / Yes
Setting an Anynet+ Device to turn Off automatically when the TV is turned Off.

The active source on the TV remote must be set to TV to use the Anynet+ function.
If you set Auto Turn Off to Yes, connected external devices are also turned off when the 
TV is turned off. If an external device is still recording, it may or may not turn off.

Switching between Anynet+ Devices

1.	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.	 Press the ▲ or ▼ button to select Device List, then press the ENTERE button.

Anynet+ devices connected to the TV are listed.
If you cannot find a device you want, press the red button to scan for devices. 

3.	 Press the ▲ or ▼ button to select a particular device and press the ENTERE button. It 
is switched to the selected device.

Only when you set Anynet+ (HDMI-CEC) to On in the Application menu, the Device 
List menu appears.

Switching to the selected devices may take up to 2 minutes. You cannot cancel the 
operation during the switching operation.
The time required to scan for devices is determined by the number of connected devices.
When the device scan is complete, the number of devices found are not displayed.
Although the TV automatically searches the device list when the TV is turned on via the power button, devices connected to 
the TV may not always be automatically displayed in the device list. Press the red button to search for the connected device.
If you have selected external input mode by pressing the SOURCE button, you cannot use the Anynet+ function. Make sure to 
switch to an Anynet+ device by using the Device List.

Anynet+ Menu
The Anynet+ menu changes depending on the type and status of the Anynet+ devices connected to the TV.

Anynet+ Menu Description
View TV Anynet+ mode changes to TV broadcast mode.
Device List Shows the Anynet+ device list.

(device_name) Menu Shows the connected device menus. E.g. If a DVD recorder is connected, the disc 
menu of the DVD recorder will appear.

(device_name) INFO Shows the play menu of the connected device. E.g. If a DVD recorder is connected, 
the play menu of the DVD recorder will appear.

Recording: (*recorder) Starts recording immediately using the recorder. (This is only available for devices that 
support the recording function.)

Stop Recording: (*recorder) Stops recording.
Receiver Sound is played through the receiver.

If more than one recording device is connected, they are displayed as (*recorder) and if only one recording device is 
connected, it will be represented as (*device_name).
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TV Remote Control Buttons Available in Anynet+ Mode

Device Type Operating Status Available Buttons

Anynet+ Device

After switching to the device, when the 
menu of the corresponding device is 
displayed on the screen.

Numeric buttons
▲/▼/◄/►/wheel/ ENTERE buttons
Colour buttons / EXIT button

After switching to the device, while playing 
a file

π(Backward search) / μ(Forward search) / 
∫(Stop) / ∂(Play) / ∑(Pause)

Device with built-in 
Tuner

After switching to the device, when you 
are watching a TV program P > / P < button

Audio Device When Receiver is activated Y / MUTE button

The Anynet+ function only works when the active source on the TV remote control is set to TV.
The ∏ button works only while in the recordable state.
You cannot control Anynet+ devices using the buttons on the TV. You can control Anynet+ devices only using the TV remote 
control.
The TV remote control may not work under certain conditions. If this occurs, reselect the Anynet+ device.
The Anynet+ functions do not operate with other manufacturers’ products.
The π, μ operations may differ depending on the device.

Recording
You can make a recording of a TV program using a Samsung recorder.
1.	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.	 Press the ▲ or ▼ button to select Recording Immediately and press the ENTERE 

button. Recording begins.
When there is more than one recording device
When multiple recording devices are connected, the recording devices are listed. 
Press the ▲ or ▼ button to select a recording device and press the ENTERE 
button. Recording begins.
When the recording device is not displayed select Device List and press the Red 
button to search devices

3.	 Press the EXIT button to exit.
You can record the source streams by selecting Recording: (device_name).
Pressing the ∏ button will record whatever you are currently watching. If you are watching video from another device, 
the video from the device is recorded.
Before recording, check whether the antenna jack is properly connected to the recording device. To properly connect an 
antenna to a recording device, refer to the recording device’s users manual.

Listening through a Receiver (Home theatre)
You can listen to sound through a receiver instead of the TV speaker.
1.	 Press the TOOLS button. Press the ENTERE button to select Anynet+ (HDMI-CEC).
2.	 Press the ▲ or ▼ button to select Receiver. Press the ◄ or ► button to select On or Off.
3.	 Press the EXIT button to exit.

If your receiver supports audio only, it may not appear in the device list.
The receiver will work when you have properly connected the optical in jack of the 
receiver to the DIGITAL AUDIO OUT (OPTICAL) jack of the TV.
When the receiver (home theatre) is set to On, you can hear sound output from 
the TV’s Optical jack. When the TV is displaying a DTV(air) signal, the TV will send 
out 5.1 channel sound to the Home Theatre receiver. When the source is a digital component such as a DVD and is 
connected to the TV via HDMI, only 2 channel sound will be heard from the Home Theatre receiver.
If there is a power interruption to the TV when the Receiver is set to On (by disconnecting the power cord or a power 
failure), the Speaker Select may be set to External Speaker when you turn the TV on again.
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Troubleshooting for Anynet+

Problem Possible Solution
Anynet+ does not work. Check if the device is an Anynet+ device. The Anynet+ system supports Anynet+ devices only.

Connect only one receiver (home theatre).
Check if the Anynet+ device power cord is properly connected.
Check the Anynet+ device’s Video/Audio/HDMI 1.3 cable connections.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Check whether the TV remote control is in TV mode.
Check whether it is Anynet+ exclusive remote control.
Anynet+ doesn’t work in certain situations. (Searching channels, Operating Media Play, Plug & 
Play, etc.)
When connecting or removing the HDMI 1.3 cable, please make sure to search devices again or 
turn your TV off and on again.
Check if the Anynet+ Function of Anynet+ device is set on.

●
●
●
●
●
●
●
●

●

●
I want to start Anynet+. Check if the Anynet+ device is properly connected to the TV and check if the Anynet+ (HDMI-

CEC) is set to On in the Anynet+ Setup menu.
Press the TV button on the TV remote control to switch to TV. Then press the TOOLS button to 
show the Anynet+ menu and select a menu you want.

●

●

I want to exit Anynet+. Select View TV in the Anynet+ menu.
Press the SOURCE button on the TV remote control and select a device other than Anynet+ 
devices.
Press P >/<, PRE-CH, and FAV.CH to change the TV mode. (Note that the channel button 
operates only when a tuner-embedded Anynet+ device is not connected.)

●
●

●

The message 
‘Connecting to Anynet+ 
device...’ appears on the 
screen.

You cannot use the remote control when you are configuring Anynet+ or switching to a view 
mode.
Use the remote control when the Anynet+ setting or switching to view mode is complete.

●

●

The Anynet+ device does 
not play.

You cannot use the play function when Plug & Play is in progress.●

The connected device is 
not displayed.

Check whether or not the device supports Anynet+ functions.
Check whether or not the HDMI 1.3 cable is properly connected.
Check whether Anynet+ (HDMI-CEC) is set to On in the Anynet+ setup menu.
Search Anynet+ devices again.
You can connect an Anynet+ device using the HDMI 1.3 cable only. Some HDMI cables may not 
support Anynet+ functions.
If it is terminated by an abnormal situation such as disconnecting the HDMI cable or power cord 
or a power failure, please repeat the device scan.

●
●
●
●
●

●

The TV program cannot 
be recorded.

Check whether the antenna jack on the recording device is properly connected.●

The TV sound is not 
output through the 
receiver.

Connect the optical cable between TV and the receiver.●

¦
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RECOMMENDATIONS

Teletext Feature
Most television stations provide written information services via Teletext. The index page of the Teletext service gives you 
information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 
control buttons.

For Teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 
some pages may not be displayed.

1	 0 (mode)
Press to select the Teletext mode 
(LIST/ FLOF). If you press it in 
the LIST mode, it switches into 
the List save mode. In the List 
save mode, you can save Teletext 
page into list using the 8(store) 
button.

2	 8 (store)
Used to store the Teletext pages.

3	 4 (size)
Press to display the double-size 
letters in the upper half of the 
screen. For lower half of the 
screen, press it again. To display 
normal screen, press it once 
again.

4	 5 (reveal)
Used to display the hidden text 
(answers to quiz games, for 
example). To display normal 
screen, press it again.

5	 Colour buttons (red/green/yellow/
blue)
If the FASTEXT system is used 
by a broadcasting company, the 
different topics covered on a 
Teletext page are colour-coded 
and can be selected by pressing 
the coloured buttons. Press 
one of them corresponding 
to the required. The page is 
displayed with other coloured 
information that can be selected 
in the same way. To display the 
previous or next page, press the 
corresponding coloured button.

6	 / (Teletext on/mix)
Press to activate Teletext mode after 
selecting the channel providing the 
Teletext service. Press it twice to 
overlap the Teletext with the current 
broadcasting screen.

7	 : (exit)
Exit from the Teletext display.

8	 1 (sub-page)
Used to display the available sub-page.

9	 2 (page up)
Used to display the next Teletext page.

0	 3 (page down)
Used to display the previous Teletext 
page.

!	 9 (hold)
Used to hold the display on a given 
page if the selected page is linked with 
several secondary pages which follow 
on automatically. To resume, press it 
again.

@	 6 (index)
Used to display the index (contents) 
page at any time while you are viewing 
Teletext.

#	 7 (cancel)
Used to display the broadcast when 
searching for a page.

You can change Teletext pages by pressing the numeric buttons on the remote control. 
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The Teletext pages are organized according to six categories:

Part Contents
A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.

Teletext information is often divided between several pages displayed in sequence, which can be accessed by:
Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.
Depending upon the transmission, blank side panels can occur when displaying Teletext.
In these cases, additional graphics or text is not transmitted.
Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 
Teletext transmission.
Press the TV button to exit from the Teletext display.

Installing the Stand
Preset: Place the Guide Stand and Cover Neck onto the stand and fasten it using the 
screws. Applicable to 32inch models only.

1.	 Attach your LCD TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

2.	 Fasten screws at position 1 and then fasten screws at position 2.
Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 
placed down, it may lean to one side.
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Disconnecting the Stand

1.	 Remove four screws from the back of the TV.
2.	 Separate the stand from the TV.

Two or more people should carry the TV.
3.	 Cover the bottom hole with the cover.

Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the 
Wall Mount items. Contact a technician for assistance when installing the wall mounted 
bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself or 
others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.

Remove the stand and cover the bottom hole with a cap and fasten with two screws.

Assembling the Cables

Enclose the cables in the Holder-Wire Cable so that the cables are not visible through the 
transparent stand.

Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer.
Refer to the manual provided with the Kensington Lock for proper use. 

The locking device has to be purchased separately.
The location of the Kensington Lock may be different depending on its model.

1.	 Insert the locking device into the Kensington slot on the LCD TV (1) and turn it in the 
locking direction (2).

2.	 Connect the Kensington Lock cable (3).
3.	 Fix the Kensington Lock to a desk or a heavy stationary object.
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Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your 
children do not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious 
injuries or death. Follow all safety precautions provided on the included Safety Flyer. For added stability, 
install the anti-fall device for safety purposes, as follows.

To avoid the TV from falling:
1. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.
You may need additional material such as an anchor depending on the type of 
wall.
Since the necessary clamps, screws, and string are not supplied, please 
purchase these additionally.

2. Remove the screws from the centre back of the TV, put the screws into the clamps, 
and then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications
For a 17 ~ 29 Inch LCD TV: M4 X 15 / For a 32 ~ 40 Inch LCD TV: M6 X 15

3. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
string and then tie the string tightly.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Untie the string before moving the TV.

4. Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.
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Troubleshooting: Before Contacting Service Personnel

No sound or picture Check that the mains lead has been connected to a wall socket.
Check that you have pressed the button on your set.
Check the picture contrast and brightness settings.
Check the volume.

Normal picture but no sound Check the volume.
Check whether the MUTEM button has been pressed on the remote control.
Check the Speaker Select settings.

Screen is black and power 
indicator light blinks steadily

On your computer check; Power, Signal Cable.
The TV is using its power management system.
Move the computer’s mouse or press any key on the keyboard.

No picture or black and white 
picture

Adjust the colour settings.
Check that the broadcast system selected is correct.

Sound and picture interference Try to identify the electrical appliance that is affecting the set and move it further away.
Plug your set into a different mains socket.

Blurred or snowy picture, 
distorted sound

Check the direction, location and connections of your aerial.
This interference is often due to the use of an indoor aerial.

Remote control malfunctions Replace the remote control batteries.
Clean the upper edge of the remote control (transmission window).
Check the battery terminals.

‘Check signal cable.’ message is 
displayed

Check that the signal cable is firmly connected to the PC or video sources.
Check that the PC or video sources are turned on.

On PC mode, ‘Not Supported 
Mode.’ message is displayed

Check the maximum resolution and the frequency of the video adaptor.
Compare these values with the data in the Display Modes.

The damaged picture appears in 
the corner of the screen

If Screen Fit is selected in some external devices, the damaged picture may appear in the corner of the 
screen. This symptom is caused by external devices, not TV.

The ‘Resets all settings to 
the default values.’ message 
appears.

This appears when you press and hold the EXIT button for a while. The product settings are reset to the 
factory defaults.

You may see small particles if 
you look closely at the edge of 
the bezel surrounding the TV 
screen.

This is part of the product’s design and is not a defect.

This TFT LCD panel uses a panel consisting of sub pixels (6 220 800) which require sophisticated technology to produce. 
However, there may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the 
product.
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Specifications

Model Name LE32B550A, LE32B551A
LE32B553M, LE32B554M

LE37B550A, LE37B551A
LE37B553M, LE37B554M

Screen Size 
(Diagonal) 32 inches 37 inches
PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz
Sound
(Output) 10W X 2 10W X 2
Dimensions (WxDxH)
Body
With stand

794 X 77 X 524 mm
794 X 240 X 570 mm

917 X 79 X 592 mm
917 X 255 X 658 mm

Weight
With Stand 13 kg 16 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
(Left / Right) -20˚ ~ 20˚

Model Name LE40B550A, LE40B551A
LE40B553M, LE40B554M

LE46B550A, LE46B551A
LE46B553M, LE46B554M

Screen Size 
(Diagonal) 40 inches 46 inches
PC Resolution
(Optimum) 1920 x 1080 @ 60 Hz 1920 x 1080 @ 60 Hz
Sound
(Output) 10W X 2 10W X 2
Dimensions (WxDxH)
Body
With stand

982 X 79 X 626 mm
982 X 255 X 676 mm

1116 X 79 X 706 mm
1116 X 27 5 X 77 0mm

Weight
With Stand 18 kg 23 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
(Left / Right) -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.
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Цифровое телевещание (DVB-T). Примечание
1. 	 Функции цифрового телевидения (dvb) доступны только в тех странах и регионах, где передаются цифровые наземные 

сигналы dvb-t (mpeg2 и mpeg4 avc) или где имеется доступ к совместимой услуге кабельного телевидения DVB-C 
(MPEG2 и MPEG4 AAC). Узнайте у местного дилера о возможности приема сигнала DVB-T или DVB-C.

2.	 DVB-T – это стандарт цифрового наземного телевещания, принятый консорциумом европейских организаций DVB, 
а DVB-C – это стандарт цифрового кабельного телевидения. Однако некоторые дифференцированные функции, 
такие как EPG (Electric Program Guide), VOD (Video on Demand) и другие, не входят в эту спецификацию. Поэтому в 
настоящее время они не поддерживаются. 

3.	 Несмотря на то, что данный телевизор поддерживает последние стандарты DVB-T и DVB-C [с августа 2008 года], 
компания не гарантирует совместимость с последующими стандартами цифрового наземного ТВ-вещания DVB-T и 
цифрового кабельного вещания DVB-C. 

4.	 В зависимости от того, в какой стране или регионе используется телевизор, некоторые поставщики услуг кабельного 
телевидения могут взимать отдельную плату за данную услугу. При этом пользователю необходимо будет принять 
условия предоставления услуги.

5.	 Некоторые функции цифрового ТВ могут быть недоступны в отдельных странах или регионах, кроме того не все 
поставщики могут обеспечить правильную работу DVB-C.

6.	 Для получения более подробной информации обратитесь в местный центр по обслуживанию клиентов Samsung.

Меры предосторожности при отображении неподвижного изображения. 
Неподвижное изображение может серьезно повредить экран телевизора.

Не следует оставлять неподвижное или частично неподвижное изображение на ЖК-панели более двух часов, 
поскольку это может привести к возникновению эффекта остаточного изображения. Подобное остаточное изображение 
также известно как выгорание экрана. Во избежание такого эффекта уменьшите уровень яркости и контрастности 
экрана при отображении неподвижных изображений.

При длительном просмотре ЖК-телевизора в формате 4:3 в его правой, левой и центральной части 
могут появиться следы границ изображения, что объясняется продолжительной неравномерностью 
светового излучения в разных областях экрана. Использование телевизора для воспроизведения 
DVD-дисков или подключение игровой приставки может оказать подобное воздействие на экран. 

Повреждения, вызванные вышеуказанным эффектом, не подлежат гарантийному ремонту.
Длительное отображение неподвижных изображений, например, при подключении экрана к видеоигре и компьютеру, 
может вызвать появление остаточных изображений. Во избежание возникновения подобного эффекта, при 
отображении неподвижных изображений уменьшите уровень параметров яркости и контрастности.  

© Корпорация Samsung Electronics Ltd., 2009. Все права защищены.
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Лицензия

TruSurround HD, SRS и символ  являются товарными знаками корпорации SRS Labs, Inc. 
Технология TruSurround HD использована по лицензии корпорации SRS Labs, Inc.

Произведено по лицензии Dolby Laboratories. Dolby и символ двойного D являются торговыми знаками 
Dolby Laboratories.
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Настройка телевизора

Рисунки и иллюстрации в данном руководстве пользователя представлены только для справки. Они могут отличаться 
от реального внешнего вида устройства. Конструкция и характеристики устройства могут изменяться с целью 
повышения его производительности без предварительного уведомления.

Панель управления
Цвет и форма устройства могут различаться в зависимости от модели.
Кнопки передней панели работают при прикосновении пальцем.

1	 P (ПИТАНИЕ): Используется для включения и выключения питания.
2	И ндикатор питания: Мигает и отключается при включении питания и горит в режиме ожидания.
3	 z: Используется для смены каналов. Кнопки z в экранном меню выполняют те же функции, что и 

кнопки ▼ и ▲ на пульте дистанционного управления.
4	 Y: Используется для увеличения или уменьшения громкости. 

Кнопки Y в экранном меню выполняют те же функции, что и кнопки ◄ и ► на пульте дистанционного 
управления.

5	 MENU: Нажмите для просмотра экранного меню функций телевизора.
6	 SOURCE E: Переключение между всеми доступными источниками входящего сигнала. Эта кнопка в экранном меню 

выполняет те же функции, что и кнопка ENTERE на пульте дистанционного управления.
7	 ДАТЧИК ПРИЕМА СИГНАЛА ПУЛЬТА ДИСТАНЦИОННОГО УПРАВЛЕНИЯ: Направляйте пульт дистанционного 

управления в эту точку на панели управления телевизора.
8	 ГРОМКОГОВОРИТЕЛИ
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Принадлежности

Пульт дистанционного управления и 2 
батареи (размер AAA) Кабель питания Крышка (нижняя)

Гарантийный талон/инструкция по 
технике безопасности (прилагается 

не во всех странах)
Винты для подставки (M4 X L16)� 

(в зависимости от модели) Ткань для очистки Держатель проводов
(в зависимости от модели)

Убедитесь, что следующие принадлежности прилагаются к телевизору с ЖК-экраном. Если какой-либо элемент 
комплекта отсутствует, обратитесь к дилеру.
Цвет и форма принадлежностей могут различаться в зависимости от модели.
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Соединительная панель

Цвет и форма устройства могут различаться в зависимости от модели.
1	 COMPONENT IN 

Подключение компонентного видео- / аудиокабеля.
2	 HDMI IN 1, 2, 3(DVI), 4 / DVI AUDIO IN

Подключение к гнезду HDMI устройства, оснащенного выходом HDMI.
При соединении двух устройств с помощью разъема HDMI аудиокабель не требуется.
Что такое HDMI?
HDMI (High-Definition Multimedia Interface) – это интерфейс, который обеспечивает передачу цифровых аудио- и 
видеосигналов по одному кабелю.
Различие между HDMI и DVI состоит в том, что устройство HDMI меньше по размеру и имеет функцию 
кодирования HDCP (High Bandwidth Digital Copy Protection).
На телевизоре может отсутствовать звук, а изображения могут отображаться в необычном цвете, если к 
нему подключен проигрыватель DVD/проигрыватель Blu-ray/приемник кабельного/спутникового телевизора 
(видеоприставка), поддерживающий версии HDMI, более ранние, чем 1.3. Если отсутствует звук, когда 
используется старый кабель HDMI, подключите кабель HDMI к гнезду HDMI IN 3(DVI) а аудиокабели – к гнездам 
DVI AUDIO IN на задней панели телевизора. В этом случае обратитесь в компанию, предоставившую DVD-
проигрыватель / проигрыватель Blu-ray / приемник кабельного / спутникового телевизора (видеоприставку), чтобы 
узнать версию HDMI, а затем запросить обновление.
Для подключения к внешнему устройству используйте гнездо HDMI IN 3(DVI). Для подключения к видеоразъему 
используйте кабель DVI-HDMI или адаптер DVI-HDMI (DVI-HDMI) а для аудио – гнезда DVI AUDIO IN. При 
использовании кабеля HDMI/DVI подключение следует выполнять через гнездо HDMI IN 3(DVI).
Кабели HDMI, отличные от 1.3, могут вызывать дрожание изображения на экране.

3	 PC IN [PC] / [AUDIO]
Подключение к гнездам видео- и аудиовыхода на компьютере.

Если ваш компьютер поддерживает подключение HDMI, его можно подключить к разъему HDMI IN 1, 2, 3(DVI) или 4.
Если ваш компьютер поддерживает подключение DVI, его можно подключить к разъему HDMI IN 3(DVI)/DVI AUDIO IN.

4	 ANT IN
Подключение к антенне или системе кабельного телевидения.

5	ЗА МОК KENSINGTON (в зависимости от модели)
Замок Kensington (не входит в комплект) – это устройство для крепления системы при использовании в общественных 
местах. Если необходимо использовать блокировочное устройство, обратитесь к продавцу телевизора.

Размещение замка Kensington может отличаться в зависимости от его модели.
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6	 H(НАУШНИКИ)
Можно подключить наушники к выходу наушников на телевизоре. При подключении наушников звук через встроенные 
громкоговорители выводиться не будет.

При подключении к телевизору наушников использование функций звука ограничено.
Продолжительное использование наушников с высоким уровнем громкости может привести к нарушениям слуха.
При подключении наушников к телевизору звук в динамиках отключается.
Громкость наушников и громкость телевизора регулируются отдельно.

7	 DIGITAL AUDIO OUT (OPTICAL)
Подключение к цифровому аудиоустройству, например приемнику домашнего кинотеатра.

При подключении цифровой аудиосистемы к гнезду DIGITAL AUDIO OUT (OPTICAL): уменьшите громкость 
телевизора и настройте уровень громкости с помощью регулятора уровня громкости системы.
5.1-канальное звучание возможно в том случае, если телевизор подключен к внешнему устройству, 
поддерживающему 5.1-канальное звучание.
Если для приемника (домашнего кинотеатра) установлено значение Вкл., звук будет слышен через оптический 
разъем на телевизоре. Если для телевещания используется сигнал цифрового ТВ (по воздуху), то звук будет 
воспроизводиться по 5,1-канальной системе приемника домашнего кинотеатра. Если в качестве источника 
используется цифровое устройство, например, DVD-проигрыватель / проигрыватель Blu-ray / приемник кабельного 
/ спутникового телевидения (телеприставка), который подключен к телевизору через гнездо HDMI, приемник 
домашнего кинотеатра обеспечивает только 2-канальное звучание. Если требуется 5.1-канальное звучание, 
выполните прямое подключение через цифровое выходное аудиогнездо на проигрывателе DVD-дисков / Blu-ray / 
приемнике кабельного / спутникового телевидения (телеприставке) к усилителю или домашнему кинотеатру, а не к 
телевизору.

8	 SERVICE
Разъем используется только для техобслуживания.

9	 AUDIO OUT [R-AUDIO-L]
Подключение к гнездам аудиовыхода на усилителе/домашнем кинотеатре.
При подключении аудиоусилителя к гнездам AUDIO OUT [R-AUDIO-L]: уменьшите громкость телевизора и настройте 
уровень громкости с помощью регулятора уровня громкости усилителя.

0	 EXT1, 2
Входные и выходные разъемы для внешних устройств, таких как видеомагнитофон, DVD-проигрыватель, игровая 
приставка или проигрыватели видеодисков.

В режиме EXT выходной сигнал цифрового ТВ поддерживает только видео в формате MPEG SD и аудио.
Характеристики входных / выходных разъемов

Разъем Вход Выход
Видео Аудио (Л/П) RGB Видео + аудио (Л / П)

EXT 1 O O O Доступен только выход телевизионного сигнала или сигнала 
DTV.

EXT 2 O O X Выходной сигнал, который можно выбрать.
!	 AV IN [VIDEO] / [R-AUDIO-L]

Видео- и аудиовходы для внешних устройств, таких как видеокамера или видеомагнитофон.
@	 USB

Разъем для обновления программного обеспечения, медиа-проигрывателя и т.д.
#	 COMMON INTERFACE

Если в гнездо стандартного интерфейса не вставлена карта, при приёме некоторых каналов может появиться 
надпись 'Зашифрованный сигнал'.
Сопровождающая информация, содержащая телефонный номер, идентификационный номер карты CI CARD, 
идентификационный номер хоста будет выведена на экран через 2-3 минуты. Если появится сообщение об 
ошибке, обратитесь к поставщику услуг цифрового телевидения.
После завершения конфигурирования информации о каналах на экране отобразится сообщение 'Обновление 
завершено', означающее, что список каналов обновлен.
Карту CI CARD необходимо получить у местного поставщика услуг цифрового телевидения. Извлеките карту CI 
CARD, аккуратно придерживая ее, поскольку падение карты может привести к ее повреждению.
Вставьте карту CI-Card в направлении, указанном на ней.
Размещение гнезда COMMON INTERFACE может отличаться в зависимости от его модели. 
Во многих странах и регионах модуль CAM не поддерживается. Уточните данную информацию у официального 
дилера.
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Пульт дистанционного управления
Пульт дистанционного управления можно использовать на расстоянии не более 7 метров от телевизора.
На работу пульта ДУ может влиять яркий свет.
Цвет и форма устройства могут различаться в зависимости от модели.

1	 POWER : Включение и 
выключение телевизора.

2	 ЦИФРОВЫЕ КНОПКИ : 
Используются для смены 
каналов.

3	 E : выполняет ту же функцию, 
что и кнопка ENTERE 
кнопок со стрелками. Если 
при переключении каналов с 
помощью номерных кнопок 
набрать номер канала, а затем 
нажать кнопку ENTERE, 
будет немедленно выбран 
нужный канал.

4	 Y : Используется для 
увеличения или уменьшения 
громкости.

5	 SOURCE : Используется 
для отображения и выбора 
доступных источников 
видеосигнала.

6	 CH LIST : используется для 
отображения списков каналов 
на экране.

7	 TOOLS : Используется для 
быстрого выбора часто 
используемых функций.

8	 INFO : Используется для 
отображения информации на 
экране телевизора.

9	 ЦВЕТНЫЕ КНОПКИ : 
Используйте эти кнопки при 
выборе меню Список каналов, 
Media Play и т.д.

!	 Двойной : выбора звукового 
эффекта.

@	 Используйте эти кнопки в 
режимах DMA, Media Play и 
Anynet+. (∏: данный пульт 
дистанционного управления 
можно использовать для 
управления записью с 
помощью устройств записи 
Samsung с функцией Anynet+)

#	 TV : Используется 
непосредственно для 
выбора режима просмотра 
телепрограмм.

$	 PRE-CH : Используется 
для возврата к ранее 
просматриваемому каналу.

%	 MUTE M : Нажмите для 
временного отключения звука. 

^	 > P < : Используется для 
смены каналов.

&	 MENU : вызов главного 
экранного меню.

*	 FAV.CH : Используется 
для отображения списков 
избранных каналов на экране.

(	 RETURN : Используется для 
возврата к предыдущему меню.

)	ВВЕ РХ▲ / ВНИЗ▼ / ВЛЕВО◄ 
/ ВПРАВО► / ENTERE : 
Используются для выбора 
элементов меню и изменения 
значений параметров.

a	 EXIT : Используется для 
выхода из меню.

b	 P.SIZE : выбор размера 
изображения.

c	 MEDIA.P : позволяет 
воспроизводить музыкальные 
файлы и изображения.

d	 SUBT. : Отображение 
субтитров.

e	 GUIDE : Отображение 
электронного справочника по 
программам (EPG).

Функции телетекста
5	 0: выбор режима телетекста 

(LIST/FLOF)
6	 8: сохранение телетекста
7	 4: выбор размера телетекста
8	 5: открытие телетекста
9	 Выбор темы Fastext
0	 /: или выберите 

Телетекст, Double или Mix.
#	 :: выход из режима 

телетекста
$	 1: дополнительная страница 

телетекста
^	 2: следующая страница 

телетекста
3: предыдущая страница 
телетекста

&	 6: указатель телетекста
(	 9: удержание страницы 

телетекста
a	 7: отмена телетекста
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Установка батарей в пульт дистанционного управления
1.	 Снимите крышку на задней панели пульта дистанционного управления, подняв ее 

вверх, как показано на рисунке.
2.	 Установите две батареи размера AAA. 

Убедитесь, что полюсы ‘+’ и ‘–’ батареи соответствуют полюсам на рисунке внутри 
отделения.

3.	 Вставьте крышку обратно.
Если пульт дистанционного управления не используется в течение долгого 
времени, извлеките батареи и храните их в прохладном сухом месте. 

Если пульт дистанционного управления не работает, проверьте следующее:
Включен ли телевизор? 
Правильно ли установлены положительный и отрицательный полюсы батареи?
Не разряжены ли батареи?
Возможно, отключено питание или отсоединен кабель питания?
Нет ли поблизости люминесцентного излучения или неоновой вывески?ЭКСПЛУАТАЦИЯ

Просмотр меню
Перед использованием телевизора выполните описанные ниже шаги, чтобы узнать о том, как осуществляется навигация 
по меню для выбора и настройки различных функций.

  

Использование экранного дисплея
Операция получения доступа зависит от того, какое меню выбрано.
1.	 Нажмите кнопку MENU.

2.	 На экране появится главное меню. В левой части меню расположены значки: 
Изображение, Звук, Канал, Установка, Вход, Приложение, Поддержка.

3.	 Выберите значок, нажимая кнопку ▲ или ▼.

4.	 Затем нажмите кнопку ENTERE, чтобы получить доступ к подменю значка.
5.	 С помощью кнопки ▲ или ▼ выберите подменю значка.

6.	 Нажмите кнопку ◄ или ►, чтобы уменьшить или увеличить значение определенного 
параметра. Экранный дисплей для настроек может быть разным и зависит от 
выбранного меню.

7.	 Нажмите кнопку ENTERE для завершения конфигурации. Чтобы выйти, нажмите 
кнопку EXIT.
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MENU
Отображение главного экранного 

меню.

ENTERE/ направления
Перемещение курсора для выбора 

элемента. Выбор элемента, 
на который наведен курсор. 
Подтверждение настройки.

RETURN
Возврат к предыдущему меню.

Выход
Выход из экранного меню.

Режим	 : Стандартный	 ▶

Подсветка	 : 7
Контраст	 : 95
Яркость	 : 45
Четкость	 : 50
Цвет	 : 50
Тон (З/К) 	 : З50/К50
Дополнительные параметры

Изображение

Режим	 : Стандартный

Подсветка	 : 7	 ▶

Контраст	 : 95
Яркость	 : 45
Четкость	 : 50
Цвет	 : 50
Тон (З/К) 	 : З50/К50
Дополнительные параметры
Параметры изображения

Изображение

7

 U Перем.    L Настр.     E Вход     R Возврат

      ▲
Подсветка
      ▼

Значок справки
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Функция Plug & Play
При первом включении телевизора автоматически и поочередно восстанавливаются основные параметры.
1.	 Нажмите кнопку POWER на пульте дистанционного управления. 

Можно также использовать кнопку POWERP на телевизоре. 
Отобразится сообщение Выбор языка экранного меню.

2.	 Нажмите кнопку ENTERE. Выберите язык, нажав кнопку ▲ или ▼. Нажмите кнопку 
ENTERE для подтверждения выбора.

3.	 Нажмите кнопку ◄ или ► для выбора пункта Демонстрация или Домашний , затем 
нажмите копку ENTERE.

Для получения наилучшего изображения в домашних условиях рекомендуется 
перевести телевизор в режим Домашний.
Демонстрация предназначенa только для точек розничной торговли.
Если для устройства случайно выбран режим Демонстрация и нужно вернуться в режим Домашний 
(стандартный): нажмите кнопку регулировки громкости на телевизоре. При отображении экранного меню 
громкости нажмите на телевизоре кнопку MENU и удерживайте ее в течение 5 секунд.

4.	 Нажмите кнопку ENTERE. Выберите страну, нажав кнопку ▲ или ▼. Нажмите кнопку ENTERE для подтверждения 
выбора.

5.	 С помощью кнопки ▲ или ▼ выберите пункт Антенна или Кабель, затем нажмите кнопку ENTERE.
Антенна: сигнал внешней антенны.
Кабель: сигнал кабельной антенны.

6.	 Нажмите кнопку ▲ или ▼ для выбора источника канала для сохранения. Нажмите кнопку ENTERE для выбора 
пункта Пуск.

Если в качестве источника антенны выбрать пункт Кабель, появится возможность дополнительного действия: 
настройки значения для поиска цифровых каналов. Для получения дополнительных сведений выберите Канал → 
Автонастройка.
Цифровые и аналоговые: цифровые и аналоговые каналы.
Цифровые: цифровые каналы.
Аналоговые: аналоговые каналы.
Поиск каналов начнется и закончится автоматически.
Нажмите кнопку ENTERE в любой момент времени, чтобы прервать процесс сохранения.
После сохранения всех доступных каналов на экране отобразится сообщение Режим установки времени.

7.	 Нажмите кнопку ENTERE. С помощью кнопки ▲ или ▼ выберите пункт Авто, затем нажмите кнопку ENTERE.
Если выбрано значение Ручной, отобразится сообщение Установка времени и даты. 
При приеме цифрового канала время будет установлено автоматически. Если канал не цифровой, для установки 
времени выберите пункт Ручной.

8.	 Отобразится описание метода подключения, обеспечивающего наибольшее качество отображения на экране высокой 
четкости. Ознакомьтесь с описанием и нажмите кнопку ENTERE.

9.	 Появится сообщение Приятного просмотра. После завершения процедуры нажмите кнопку ENTERE.

Сброс настроек этой функции
1.	 Для отображения меню нажмите кнопку MENU. С помощью кнопки ▲ или ▼ 

выберите пункт Установка, затем нажмите кнопку ENTERE.
2.	 Нажмите кнопку ENTERE еще раз, чтобы выбрать пункт Plug & Play.
3.	 Введите 4-значный PIN-код. По умолчанию для телевизора используется PIN-код ‘0-0-

0-0’.
Если требуется изменить PIN-код, используйте функцию Изменение PIN. 
Функция Plug & Play доступна только в режиме TV.
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Plug & Play	 	 ▶

Язык	 : Русский
Время
 Игровой режим  	 : Выкл.
Замок	 : Вкл.
Изменение PIN  
Родит. блокировка
Субтитры

Установка
Выбор языка экранного меню..

Язык 	 : Русский 	 	 ▶

E Вход

Plug & Play
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Канал

Меню Канал

Страна

Аналоговый канал
Изменение страны для приема аналоговых каналов.

Цифровой канал
Изменение страны для приема цифровых каналов.

Отобразится окно ввода PIN-кода. Введите 4-значный PIN-код.

Автонастройка 
Можно произвести поиск каналов в доступных частотных диапазонах (диапазоны частот зависят от страны). 
Автоматически присвоенные номера программ могут не соответствовать реальным или желаемым номерам программ.

При блокировке каналов с помощью функции Замок отобразится окно ввода PIN-кода.

Антенна / Кабель
Сигнал антенны для сохранения.

Цифровые и аналоговые: цифровые и аналоговые каналы.
Цифровые: цифровые каналы.
Аналоговые: аналоговые каналы.

При выборе меню Кабель → Цифровые и аналоговые или Кабель → Цифровые:
Укажите значение для поиска кабельных каналов.

Режим поиска → Полный / Сеть / Быстрый
Быстрый

Network ID: отображение идентификатора сети.
Частота: отображение частоты канала. (Различаются в зависимости от страны)
Модуляция: отображение доступных значений модуляции.
Скорость передачи: отображение допустимых значений скорости потока.

Сканирование всех каналов действующих телевизионных станций и сохранение их в памяти телевизора.
При необходимости остановки выполнения функции автосохранения нажмите кнопку ENTERE.
Отобразится сообщение Остановить автонастройку? .
Выберите Да, нажав кнопку ◄ или ►, затем нажмите кнопку ENTERE.

Ручная настройка
Сканирование каналов вручную и сохранение их в памяти телевизора.
При блокировке каналов с помощью функции Замок отобразится окно ввода PIN-кода.

Цифровой канал
Сохранение цифровых каналов вручную.

Цифровой канал доступен только в режиме DTV.
Канал: установка номеров каналов с помощью кнопок ▲, ▼ или цифровых кнопок (0~9).
Частота: установка частоты с помощью цифровых кнопок.
Полоса пропуск.: установка полосы пропускания с помощью кнопок ▲, ▼ или цифровых кнопок (0~9).
После завершения этой процедуры список каналов обновляется.

Аналоговый канал
Сохранение аналоговых каналов вручную.

Программа (номер программы, присвоенный каналу): установка номера программы с помощью кнопок ▲, ▼ или 
цифровых кнопок (0~9).
Система цвета → Авто / PAL / SECAM / NTSC4.43: установка значений цветовой системы помощью кнопки ▲ или ▼.
Система звука → BG / DK / I / L: установка значений звуковой системы с помощью кнопки ▲ или ▼.
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Страна	 	 ▶

Автонастройка 
Ручная настройка
Параметр поиска в кабельной сети
Полн. руков.
Мини гид
Гид по умолч.	 : Полн. руков.
Список каналов

Канал
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Канал (если номер сохраняемого канала известен): Нажмите кнопку ▲ или ▼ для выбора C (канал с антенны) или S 
(кабельный канал). Нажмите кнопку ►, затем с помощью кнопки ▲, ▼ или цифровых кнопок (0~9) выберите желаемый 
номер.

Также можно выбрать номер канала напрямую, нажимая цифровые кнопки (0~9).
Если слышен странный звук или звук не слышен вообще, еще раз выберите стандарт звука.
Поиск (если номера каналов неизвестны): чтобы начать поиск, нажмите кнопку ▲ или ▼. Тюнер будет вести поиск 
в диапазоне частот, пока изображение первого канала или выбранного канала не отобразится на экране.

Сохр. (при сохранении канала и соответствующего номера программы): выберите OK, нажав кнопку ENTERE.
Режимы каналов
P (Режим программы): по окончании настройки всем станциям телевещания в регионе присваиваются номера 
программ от P00 до P99. В этом режиме можно выбрать канал, введя присвоенный ему номер программы.
C (Режим каналов с антенны): в этом режиме можно выбрать канал посредством ввода номера, присвоенного для 
конкретной станции.
S (Режим кабельных каналов): в этом режиме можно выбрать канал, введя номер, присвоенный каналу 
кабельного телевидения.

Кабельные параметры поиска (в зависимости от страны)
С помощью данной функции можно вручную добавить ряд каналов, для сканирования которых можно будет использовать 
режим Full Search или функцию Автонастройка .

Частота начала (начальная частота): задание начальной частоты (зависит от страны)
Частота окончания (конечная частота): задание конечной частоты (зависит от страны)
Модуляция: отображение доступных значений модуляции.
Скорость передачи: отображение допустимых значений скорости потока.

Полн. руков. / Мини гид
Данные справочника по программам (EPG) представляются вещательными компаниями. В зависимости от передаваемой 
информации по определенному каналу могут отображаться устаревшие сведения по программам или совсем не 
отображаться. Данные на экране обновляются автоматически при появлении новой информации.

Для отображения меню гида можно также нажать кнопку GUIDE. (Чтобы настроить функцию Гид по умолч., см. 
описание.)

Полн. руков.
Отображение информации о программах передач в ближайший час. Можно настроить отображение сведений о 
программах в ближайшие два часа. Для просмотра информации можно выполнять прокрутку вперед и назад.

Мини гид
Информация о каждой программе отображается на экране Мини гид для текущего канала, начиная с текущей программы и 
далее, в соответствии с очередностью по времени начала программ.

Гид по умолч. → Мини гид / Полн. руков.
Пользователь может выбрать, какой вариант документа: Мини гид или Полн. руков. будет отображаться при нажатии 
кнопки GUIDE на пульте дистанционного управления.

Список каналов
Для получения подробных сведений об использовании меню Список каналов см. инструкции раздела Управление 
каналами.

Эти параметры можно также установить, нажав кнопку CH LIST на пульте дистанционного управления.

Режимы каналов
При использовании кнопки P >/< можно переключать каналы, используя выбранный список каналов.

Добавл.каналы
Переключение каналов, сохраненных в списке каналов.

Любимые каналы
Переключение каналов, сохраненных в списке избранных каналов.
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Точная настройка
Если принимается четкий сигнал без помех, то нет необходимости производить точную настройку, т.к. это уже было 
выполнено автоматически во время поиска и сохранения каналов. Если сигнал слабый или искаженный, то можно 
выполнить точную настройку на принимаемый сигнал канала вручную.

В строке канала справа от номера сохраненного канала, настроенного с помощью функции точной настройки, 
появится звездочка “*”.
Чтобы сбросить точную настройку, выберите пункт Сброс, нажав кнопку ▲ или ▼, а затем кнопку ENTERE.
Точную настройку можно производить только для аналоговых каналов.

Использование полного руководства / мини-руководства

Требуемая операция... Необходимые действия...
Просмотр программы из списка EPG Выберите программу, нажав кнопку ▲, ▼, ◄, ►.
Закрытие окна гида Нажмите синюю кнопку
Если выбрать следующую программу, она будет включена в расписание, и появится значок часов. При повторном 
нажатии кнопки ENTERE нажмите кнопку ◄, ► для выбора функции Отмена расписаний; программирование будет 
отключено, значок часов исчезнет. 
Просмотр информации о программе Выберите нужную программу, нажав кнопку ▲, ▼, ◄, ►. 

Выделив нужную программу, нажмите кнопку INFO.
Название программы отображается в верхней части экрана по центру. 

Нажмите кнопку INFO для получения подробной информации. Доступна подробная информация о следующих функциях: 
номер канала, время работы, строка состояния, уровень родительского ограничения, качество видео (HD/SD), режимы 
звука, субтитры или телетекст, языки субтитров или телетекста, краткое описание выделенной программы. “...” 
отображается, если описание слишком длинное.
Переключение между режимами отображения 
программы передач Мини гид и Полн. руков.

Несколько раз нажмите красную кнопку.

В режиме полного руководства: 
быстрая прокрутка назад (24 часа) 
быстрая прокрутка вперед (24 часа)

Несколько раз нажмите зеленую кнопку.
Несколько раз нажмите желтую кнопку.

В режиме мини-руководства
быстрое отображение предыдущей страницы.
быстрое отображение следующей страницы.

Нажмите зеленую кнопку.
Нажмите желтую кнопку.

❑

N

N
N

Полн. руков.

E Часы      Информация      Мини гид        +24 часа       Выход

DTV Cable 900 f tn                         2:10 Tue 1 Jun
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Today 2:00 - 3:00 3:00 - 4:00

Mint Extra
Loaded
40 with Dynamite MC
The Distillery
Smash Hits! Sunday

900       f tn
901       ITV Play
902       Kerrang!
903       Kiss
904       oneword
905       Hits▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

  900

E Часы      Информация     Полн. руков.      След. стр.      Выход

Мини гид DTV Cable 900 f tn

Street Hypnosis
Booze Britain

2:00
2:30
5:00

Freshmen On Campus

▼
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Управление каналами 
С помощью данного меню можно добавлять, удалять или задавать избранные каналы, а также использовать руководство 
по программам цифрового телевещания.

Все каналы
Отображение всех доступных каналов.

Добавленные каналы
Отображение всех добавленных каналов.

Избранные
Отображение всех избранных каналов.

Для выбора каналов, определенных как избранные, используйте кнопку FAV.CH на пульте дистанционного управления.

Запрограммированный
Отображение всех сохраненных программ.

Выберите канал на экране Все каналы, Добавленные каналы или Избранные с помощью кнопок ▲/▼ и нажмите 
кнопку ENTERE. После этого можно смотреть выбранный канал.
Использование цветных кнопок со списком каналов

Красная (Тип канала): переключение между элементами ТВ, Радио, Данные / др. и Все.
Зеленая (Увел.): увеличение или уменьшение шрифта.
Желтая (Выбрать): выбор нескольких списков каналов. Можно Добавить / Удалить, Добавить к избранному / 
Удалить из избранного или Блокировка / Разблокировка несколько каналов одновременно. Выберите нужные 
каналы и нажмите желтую кнопку, чтобы настроить выбранные каналы одновременно.  Слева от выбранных 
каналов отобразится метка c.
TOOLS (Инструменты): отображение меню Удалить (или Добавить), Добавить к избранному (или Удалить из 
избранного), Блокировка (или Разблокировка), Просмотр таймера, Изменить название канала, Изменение 
номера канала, Сортировка, Выбрать все, Отменить все или Автонастройка. (Меню параметров может 
отличаться в зависимости от ситуации.)

Отображаемые значки состояния каналов
A : аналоговый канал.
c: канал, выбранный с помощью нажатия желтой кнопки.
* : избранный канал.
(: принимаемая в текущий момент программа.
\ : заблокированный канал.
): сохраненная программа.

Меню параметров списка каналов (в меню Все каналы / Добавленные каналы / Избранные)
Нажмите кнопку TOOLS, чтобы открыть меню параметров.
Элементы меню параметров могут отличаться в зависимости от состояния каналов.

Добавить / Удалить
Можно удалять или добавлять каналы в список для отображения желаемых каналов.

Все удаленные каналы можно найти в списке Все каналы.
Каналы, выделенные серым цветом, удалены.
Меню Добавить отображается только для удаленных каналов.
Таким же образом можно удалить канал из меню Добавленные каналы или 
Избранные.

Добавить к избранному / Удалить из избранного
Часто просматриваемые каналы можно обозначить как избранные.

Нажмите кнопку TOOLS для отображения меню Инструменты. Можно также задать добавление или удаление из 
списка избранных каналов, выбрав Инструменты → Добавить к избранному (или Удалить из избранного).
Отобразится символ "*", и канал будет добавлен в список избранных.
Все избранные каналы будут отображаться в меню Избранные.

Блокировка / Разблокировка
Можно заблокировать канал, при этом его нельзя будет выбрать и смотреть. 

Эта функция доступна, только если для параметра Замок установлено значение Вкл.. 
Отобразится окно ввода PIN-кода. Введите 4-значный PIN-код.
По умолчанию для телевизора используется PIN-код '0-0-0-0'. Можно изменить PIN-код, выбрав в меню пункт 
Изменение PIN.
Для заблокированного канала будет отображаться символ ‘\’ .
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Все каналы

824          UKTV Gold
825          UKTV style

A 1     C --
A 2          C --
A 3          C --
A 4          C --
A 5          C --
A 6          C --
A 7          C --
A 8          C --

            Все           Тип канала      Увел.     Выбрать   T Инструменты

Удалить
Добавить к избранному
Блокировка
Просмотр таймера
Изменить название канала
Сортировка
                                       �

Добавленные каналы

824          UKTV Gold
825          UKTV style

A 1     C --
A 2          C --
A 3          C --
A 4          C --
A 5          C --
A 6          C --
A 7          C --
A 8          C --

            Все          Тип канала     Увел.     Выбрать   T Инструменты

BN68-01962D-Rus.indd   12 2009-03-04   �� 7:50:56



Русский - 13

Просмотр таймера
Если вы сохранили программу, которую хотите посмотреть, телевизор автоматически переключится на канал сохраненной 
программы, содержащийся в списке каналов, даже если вы в текущий момент смотрите другой канал. Для сохранения 
программы сначала необходимо установить текущее время. 

Можно сохранять программы, транслируемые только на сохраненных в памяти телевизора каналах.
Можно установить канал, день, месяц, год, часы и минуты непосредственно с помощью цифровых кнопок на пульте 
дистанционного управления.
Сохраненные программы будут отображаться в меню Запрограммированный.
Гид для программ цифровых каналов и сохранение программ для просмотра
При просмотре цифрового канала нажмите кнопку ►, чтобы на экране отобразилось окно гида по программам канала. 
Можно сохранить программу в соответствии с процедурами, описанными выше.

Изменить название канала (только для аналоговых каналов)
Можно присваивать каналам имена, которые отображаются на экране при каждом выборе канала.

Имена для цифровых каналов присваиваются автоматически, их нельзя переименовывать.

Изменение номера канала (только для цифровых каналов)
Также можно изменять номера каналов с помощью цифровых кнопок на пульте дистанционного управления.

Сортировка (только для аналоговых каналов)
Эта функция позволяет изменять номера программ сохраненных каналов. Использование этой функции может быть 
необходимым после выполнения процедуры автоматического сохранения каналов.

Выбрать все / Отменить все
Выбрать все: выбор всех каналов в списке каналов.
Отменить все: отмена выбора всех выбранных каналов в списке.
Для выбранного канала доступна только функция Отменить все.

Автонастройка 
Для получения подробных сведений о настройке параметров см. инструкции раздела 'Меню Каналы'.
При блокировке каналов с помощью функции Замок отобразится окно ввода PIN-кода.

Меню параметров списка каналов (в меню Запрограммированный)
Можно просматривать, изменять или удалять сохраненные программы.

Нажмите кнопку TOOLS, чтобы открыть меню параметров.

Изменение инфо  
Изменение сохраненных для просмотра программ.

Отмена расписаний
Отмена выбранных для просмотра программ.

Информация
Просмотр выбранных программ. 
(Также можно изменить сведения о сохраненной для просмотра программы.)

Выбрать все
Выбор всех сохраненных для просмотра программ.
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Запрограммированный

1 / 1 / 2009

13:59   5  TV1   ) 

18:59     2    TV3    ) The Equalizer
20:59     2    TV3    ) McMillan & Wife
21:59     2    TV3    ) M.Spillane’s mike 

            Все         Увел.     Выбрать   T Инструменты    E Информация

Изменение инфо  
Отмена расписаний
Информация
Выбрать все
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Изображение

Настройка меню изображений

Режим
Можно выбрать тип изображения для просмотра каналов, который максимально 
соответствует вкусам пользователя.

Нажмите кнопку TOOLS для отображения меню Инструменты. Режим отображения 
можно также задать, выбрав Инструменты → Реж. изображения.

Динамический
Выбор отображения с более высокой четкостью для просмотра в комнате с ярким 
освещением.

Стандартный
Выбор изображения для оптимального отображения в нормальных условиях.

Обычный
Выбор оптимального изображения, комфортного для глаз.

Кино
Выбор изображения для просмотра фильмов в темной комнате.

Подсветка / Контраст / Яркость / Четкость / Цвет / Тон(З/К)  
Несколько регулируемых параметров телевизора позволяют пользователю настроить 
качество изображения.

Подсветка: регулировка яркости подсветки ЖК-экрана.
Контраст: регулировка контрастности изображения.
Яркость: регулировка яркости изображения.
Четкость: регулировка резкости края изображения.
Цвет: регулировка насыщенности цвета изображения.
Тон(З/К): регулировка оттенков изображения.
В режимах ТВ, Ext., AV в системе PAL функция Тон(З/К) недоступна.
При изменении настроек параметров Подсветка, Контраст, Яркость, Четкость, Цвет или Тон(З/К) экранное меню 
будет изменяться соответственно.
В режиме PC можно изменять только значения параметров Подсветка, Контраст и Яркость.
Настройки можно изменять и сохранять для каждого внешнего устройства, подключаемого к входному гнезду 
телевизора.
Потребление энергии во время работы устройства можно существенно уменьшить, если уменьшить уровень яркости 
изображения. Это приведет к уменьшению общих эксплуатационных затрат.

Дополнительные параметры
Новые телевизоры Samsung позволяют делать более точные настройки изображения, чем 
в моделях, выпускавшихся ранее. 

Дополнительные параметры доступно в режиме Стандартный или Кино.
В режиме PC можно изменять только параметры Автоконтраст, Гамма и Баланс 
белого, входящие в состав меню Дополнительные параметры.

Черный тон → Выкл. / Темный / Темнее / Самый темный
Для настройки глубины экрана можно выбрать желаемый уровень черного.

Автоконтраст → Выкл. / Низкий / Средний / Высокий
Можно настроить оптимальную контрастность экрана.

Гамма
Можно отрегулировать интенсивность главных цветов (красный, зеленый, синий).
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Режим	 : Стандартный	 ▶

Подсветка	 : 7
Контраст	 : 95
Яркость	 : 45
Четкость	 : 50
Цвет	 : 50
Тон (З/К) 	 : З50/К50
Дополнительные параметры

Изображение

7

 U Перем.    L Настр.     E Вход     R Возврат

      ▲
Подсветка
      ▼

Черный тон	 : Выкл.	 	 ▶
Автоконтраст  	 : Средний
Гамма	 : 0
Цвет. интревал	 : Исходный
Баланс белого
Телесн. оттенок	 : 0
Улучшение кромок	 : Вкл.

U Перем.     E Вход     R Возврат

Дополнительные параметры
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Цвет. интревал
Цветовой интервал – это цветовая матрица, состоящая из красного, зеленого и синего цвета. Выберите предпочитаемое 
цветовое пространство, чтобы цвета отображались наиболее естественно.

Авто: в режиме автоматического цветового интервала настройка наиболее естественных цветов выполняется 
автоматически с помощью программы.
Исходный: в режиме исходного цветового пространства обеспечивается глубина и насыщенность цветов.
Польз.: настройка цветового диапазона в соответствии со своими предпочтениями.

При изменении значения регулируемого параметра изображение на экране будет обновлено.
Настройки можно изменять и сохранять для каждого внешнего устройства, подключаемого к входному гнезду 
телевизора. Например, если проигрыватель DVD-дисков подключен к гнезду HDMI 1 и в данный момент выбран, 
выполненные установки и настройки будут сохранены для этого проигрывателя DVD-дисков. 

Цвет: Красный, Зеленый, Синий, Желтый, Голубой или Пурпурный
Цвет доступно, когда для параметра Цвет. интревал установлено значение Польз..
в меню Цвет можно отрегулировать значения RGB для выбранного цвета.
Чтобы сбросить настроенное значение RGB, выберите Сброс.

Красный: настройка насыщенности красного для выбранного цвета.
Зеленый: настройка насыщенности зеленого для выбранного цвета.
Синий: настройка насыщенности синего для выбранного цвета.
Сброс: Восстановление значений параметров цветового интервала по умолчанию.

Баланс белого
Можно отрегулировать цветовую температуру для более естественного отображения цветов.

К: смещ.: настройка степени темноты красного цвета.
З: смещ.: настройка степени темноты зеленого цвета.
С: смещ.: настройка степени темноты синего цвета.
К: усил.: настройка яркости красного цвета.
З: усил.: настройка яркости зеленого цвета.
С: усил.: настройка яркости синего цвета.
Сброс: ранее настроенные установки баланса белого будут заменены на установки по умолчанию.

Телесн. оттенок
Можно выделить розовый оттенок изображения.

При изменении значения регулируемого параметра изображение на экране будет обновлено.

Улучшение кромок → Выкл. / Вкл.
Можно выделить границы объекта на изображении.
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Параметры изображения
В режиме ПК можно изменять только параметры Оттенок и Размер в меню 
Параметры изображения.

Оттенок → Хол. / Норм. / Теплый1 / Теплый2 / Теплый3
Теплый1, Теплый2 или Теплый3 активен, только если в качестве режима 
изображения выбран режим Кино.
Настройки можно изменять и сохранять для каждого внешнего устройства, 
подключаемого к входному гнезду телевизора.

Размер
Иногда может потребоваться изменить размер изображения на экране. Для телевизора предусмотрено несколько 
вариантов размера экрана, каждый из которых оптимально подходит для определенного типа видеовхода. Для приемника 
кабельного/спутникового телевидения также может быть предусмотрено несколько вариантов размера экрана. В 
большинстве случаев телевизор следует смотреть в режиме 16:9.

Эти параметры можно также установить, нажав кнопку P.SIZE на пульте дистанционного управления.
Широкий aвто: автоматическая настройка размера изображения в формат 16:9.
16:9: настройка размера изображения в формат 16:9, подходит для DVD или широковещательной трансляции.
Ш/экр.увл: увеличение формата изображения более чем 4:3.
Увел.: увеличение изображения в формате 16:9 (в вертикальном направлении) по размеру экрана.
4:3: это настройка по умолчанию для режима видео или обычного телевещания.
По разм. экрана: функция для просмотра полноразмерного изображения без обрезки при входных сигналах HDMI 
(720p/1080i/1080p) или Компонент (1080i/1080p).
В зависимости от источника входного сигнала размер изображения может отличаться.
Набор доступных элементов зависит от того, какой режим выбран.
В режиме PC можно настраивать только режимы 16:9 и 4:3.
Настройки можно изменять и сохранять для каждого внешнего устройства, подключаемого к входному гнезду 
телевизора.
При просмотре статического изображения более двух часов может появляться временное остаточное изображение.
Ш/экр.увл: нажмите кнопку ► для выбора пункта Позиция, затем нажмите кнопку ENTERE. Нажмите кнопку ▲ или 
▼ для перемещения изображения вверх и вниз. Затем нажмите кнопку ENTERE.
Увел.: нажмите кнопку ► для выбора пункта Позиция, затем нажмите кнопку ENTERE. Нажмите кнопку ▲ или 
▼ для перемещения изображения вверх и вниз. Затем нажмите кнопку ENTERE. Нажмите кнопку ► для выбора 
пункта Размер, затем нажмите кнопку ENTERE. Нажмите кнопку ▲ или ▼ для увеличения или уменьшения размера 
изображения по вертикали. Затем нажмите кнопку ENTERE.
После выбора параметра По разм. экрана в режиме HDMI (1080i/1080p) или Компонент (1080i/1080p): Выберите 
пункт Позиция, нажав кнопку ◄ или ►. С помощью кнопок ▲, ▼, ◄ или ► переместите изображение.

Сброс: Нажмите кнопку ◄ или ► для выбора пункта Сброс, затем нажмите кнопку ENTERE. Также можно 
установить исходные значения.

При использовании функции По разм. экрана, когда выбран вход HDMI 720p, 1 строка будет обрезана сверху, снизу, 
слева и справа, как при использовании функции нерабочей области.

Режим экрана → 16:9 / Ш/экр.увл / Увел. / 4:3
При установке для размера изображения значения Широкий aвто в широкоэкранном режиме 16:9 можно задать размер 
изображения, если необходим просмотр широкоформатного изображения 4:3, или не задавать его. Во всех странах 
Европы требуются различные размеры изображений, поэтому предусмотрен выбор этой функции пользователем.

16:9: установка широкоэкранного формата изображения 16:9.
Ш/экр.увл: увеличение формата изображения более чем 4:3.
Увел.: увеличение размера изображения в вертикальном направлении.
4:3: установка обычного формата изображения 4:3.
Эта функция доступна в режиме Широкий aвто.
Эта функция недоступна в режиме PC, Component и HDMI.

Цифр. ш/под → Выкл. / Низкий / Средний / Высокий / Авто
Если телевизор принимает слабый сигнал, можно включить функцию цифрового подавления шумов, которая позволяет 
снизить уровень радиопомех и устранить двоение изображения.

Если сигнал слабый, выберите другой параметр, чтобы улучшить изображение.

ЧерныйHDMI → Норм. / Низкий
Для настройки глубины экрана можно выбрать желаемый уровень черного.

Данная функция доступна, только когда внешнее устройство подключено к телевизору через разъем HDMI (сигналы 
RGB).
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Оттенок  	 : Обычное	 	 ▶
Размер	 : Широкий aвто
Режим экрана	 : 16:9
Цифр. ш/под	 : Авто
ЧерныйHDMI	 : Норм.
Режим фильм	 : Выкл.
Только синий экран 	 : Выкл.

U Перем.     E Вход     R Возврат

Параметры изображения
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Режим фильм → Выкл. / Авто1 / Авто2 
Можно выполнить настройку телевизора для автоматического распознавания и обработки видеосигналов со всех 
источников и регулировки оптимального качества изображения.

Режим фильм поддерживается при выборе TV, AV, COMPONENT(480i/1080i) и HDMI(480i/1080i).
Выкл.: отключение режима просмотра фильмов.
Авто1: автоматическая настройка изображения для обеспечения наилучшего качества при просмотре фильма.
Авто2: автоматическая оптимизация текста видео (кроме скрытых субтитров) при просмотре фильма.

Только синий экран → Выкл / Вкл
Эта функция предназначена для специалистов по настройке AV-устройств. При использовании этой функции синий 
цвет в сигнале присутствует только благодаря удалению из видеосигнала красного и зеленого цветов, что обеспечивает 
эффект фильтра синего цвета, который используется для настройки цветов и оттенков на таком видеооборудовании, как 
проигрыватели DVD-дисков, домашние кинотеатры и т.д. Благодаря этой функции можно настраивать цвет и оттенок по 
своему усмотрению и в соответствии с уровнем сигнала с каждого видеоустройства, в котором используется цветовая 
шкала красного/зеленого/синего/голубого/пурпурного/желтого цвета, не используя дополнительный фильтр синего цвета.

Только синий экран доступен, только если в качестве режима изображения выбран режим Кино или Стандартный.

Сброс настроек изображения → Сброс настроек / Отмена
Сброс всех параметров изображения до значений по умолчанию.

Сброс настроек: будут восстановлены значения по умолчанию для текущих параметров изображения.
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Использование телевизора в качестве экрана компьютера

Установка программного обеспечения компьютера (на основе Windows XP)
Параметры экрана Windows для обычного компьютера приведены ниже. В зависимости 
от установленной версии Windows и видеокарты изображение на экране компьютера 
может выглядеть иначе. Однако даже если экран выглядит иначе, основные инструкции 
по настройке параметров экрана применимы почти во всех случаях. (В противном 
случае, обратитесь к производителю компьютера или дилеру компании Samsung).
1.	 Сначала выберите ‘Панель управления’ в меню ‘Пуск’ Windows.
2.	 В открывшемся окне ‘Панель управления’ выберите ‘Оформление и темы’, чтобы 

открыть диалоговое окно.
3.	 В открывшемся окне ‘Панель управления’ выберите ‘Экран’, чтобы открыть 

диалоговое окно.
4.	 В диалоговом окне ‘Экран’ перейдите на вкладку ‘Параметры’.

Оптимальная настройка размера (разрешения): 1920 x 1080 пикселей
Если в диалоговом окне параметров экрана есть параметр частоты 
вертикальной развертки, то правильным значением будет '60' или '60 Hz'. В противном случае нажмите кнопку ‘OK’ 
и закройте диалоговое окно.

Режимы экрана
Если сигнал с системы совпадает с сигналом, посылаемым в стандартном режиме, экран настраивается автоматически. 
Если сигнал с системы не совпадает с сигналом, посылаемым в стандартном режиме, настройте режим, следуя 
инструкциям руководства пользователя видеокарты; в противном случае видеосигнал может отсутствовать. Для режимов 
отображения, перечисленных на следующей странице, качество отображения изображений на экране настроено в ходе 
изготовления устройства.

Вход D-Sub и HDMI/DVI

Режим Разрешение
Частота 

горизонтальной 
развертки (KГц)

Частота 
вертикальной 
развертки (Гц)

Частота синхронизации 
пикселей (МГц)

Полярность 
синхронизации 

(Г/В)
IBM  640 x 350 31,469 70,086 25,175 +/-

 720 x 400 31,469 70,087 28,322 -/+

MAC
 640 x 480 35,000 66,667 30,240 -/-
832 x 624 49,726 74,551 57,284 -/-
1152 x 870 68,681 75,062 100,000 -/-

VESA CVT

720 x 576 35,910 59,950 32,750 -/+
1152 x 864 53,783 59,959 81,750 -/+
1280 x 720 44,772 59,855 74,500 -/+
1280 x 720 56,456 74,777 95,750 -/+
1280 x 960 75,231 74,857 130,000 -/+

VESA DMT

640 x 480 31,469 59,940 25,175 -/-
640 x 480 37,861 72,809 31,500 -/-
640 x 480 37,500 75,000 31,500 -/-
800 x 600 37,879 60,317 40,000 +/+
800 x 600 48,077 72,188 50,000 +/+
800 x 600 46,875 75,000 49,500 +/+

1024 x 768 48,363 60,004 65,000 -/-
1024 x 768 56,476 70,069 75,000 -/-
1024 x 768 60,023 75,029 78,750 +/+
1152 x 864 67,500 75,000 108,000 +/+

1280 x 1024 63,981 60,020 108,000 +/+
1280 x 1024 79,976 75,025 135,000 +/+
1280 x 800 49,702 59,810 83,500 -/+ 
1280 x 800 62,795 74,934 106,500 -/+ 
1280 x 960 60,000 60,000 108,000 +/+
1360 x 768 47,712 60,015 85,500 +/+
1440 x 900 55,935 59,887 106,500 -/+ 
1440 x 900 70,635 74,984 136,750 -/+

1680 x 1050 65,290 59,954 146,250 -/+ 
VESA GTF 1280 x 720 52,500 70,000 89,040 -/+ 

1280 x 1024 74,620 70,000 128,943 -/-
VESA DMT / 

DTV CEA 1920 x 1080p 67,500 60,000 148,500 +/+

При использовании кабеля HDMI/DVI подключение следует выполнять через гнездо HDMI IN 3(DVI).
Режим чересстрочной развертки не поддерживается.
При выборе нестандартного видеоформата устройство может работать неправильно.
Поддерживаются режимы раздельной и композитной синхронизации. Режим SOG не поддерживается.
Кабель VGA низкого качества или слишком большой длины может стать причиной помех на изображении в режимах с 
высоким разрешением (1920 x 1080).
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Настройка подключения телевизора к компьютеру
Предварительная настройка: для выбора режима PC нажмите кнопку SOURCE.

Автоподстройка
Используйте функцию автоматической настройки, чтобы телевизор сам автоматически 
настраивал принимаемые видеосигналы.
С помощью этой функции также выполняется автоматическая точная настройка частоты и 
положения.

Нажмите кнопку TOOLS для отображения меню Инструменты. Можно также 
установить функцию автоподстройки, выбрав Инструменты → Автоподстройка.
Эта функция не работает в режиме DVI-HDMI.

Экран

Грубо / Точно
С помощью функции настройки качества изображения можно снизить уровень помех в 
изображении или избавиться от них полностью. Если уровень помех не удалось снизить 
с помощью функции точной настройки, настройте частоту как можно лучше (Грубо), а 
затем повторите точную настройку. После того, как уровень помех был снижен, настройте 
изображение таким образом, чтобы оно располагалось по центру экрана.

Положение ПК  
Настройте положение экрана компьютера, если оно не умещается на экране телевизора. 
Для настройки вертикального положения используйте кнопку ▲ или ▼. Для настройки 
горизонтального положения используйте кнопку ◄ или ►.

Сброс настр.
Можно восстановить значения параметров изображения, установленные изготовителем.
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Яркость	 : 45
Четкость	 : 50

Автоподстройка	 	 ▶

Экран
Дополнительные параметры
Параметры изображения
Сброс настроек изображения

Изображение

Грубо	 	 	 50
Точно	 	 	 0
Положение ПК  
Сброс настр.
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Звук

Настройка меню звука

Режим → Стандартный / Музыка / Кино / Четкий голос / Польз.
Нажмите кнопку TOOLS для отображения меню Инструменты. Можно также задать 
режим звука, выбрав Инструменты → Режим звука.
Стандартный: выбор обычного режима звука.
Музыка: усиление музыки по сравнению со звуком голоса.
Кино: обеспечение наивысшего качества звучания при просмотре фильмов.
Четкий голос: усиление звука голоса по сравнению с другими звуками.
Польз.: восстановление пользовательских настроек звука.

Эквалайзер
Можно настроить параметры звука в соответствии со своими предпочтениями.

Режим: выбор режима звука в предварительно заданных настройках.
Баланс Л/П: регулировка баланса между правым и левым громкоговорителями.
100Hz / 300Hz / 1KHz / 3KHz / 10KHz (регулировка полосы пропускания): Служит для регулировки уровня звука в 
разных частотных диапазонах.
Сброс: Сброс настроек эквалайзера до значений по умолчанию.

SRS TruSurround HD → Выкл. / Вкл.
SRS TruSurround HD является запатентованной технологией SRS, которая позволяет воспроизводить звук многоканального 
(5.1) телевидения через два громкоговорителя. Функция TruSurround обеспечивает воспроизведение захватывающего 
виртуального объемного звучания через систему с двумя громкоговорителями, включая встроенные громкоговорители 
телевизора. Функция работает со всеми многоканальными форматами.

Нажмите кнопку TOOLS для отображения меню Инструменты. Можно также установить функцию SRS TruSurround 
HD, выбрав Инструменты → SRS TS HD.

Язык аудио
Можно изменить установленный по умолчанию язык аудио. Отображение сведений о языке входящего потока.

Эту функцию можно выбрать во время просмотра цифрового канала.
Можно выбрать язык только среди языков, на которых транслируются программы.

Аудиоформат → MPEG / Dolby Digital
При выводе звука через главный громкоговоритель и аудиоресивер может возникать эффект эха из-за различий в скорости 
декодирования этих устройств. В этом случае используйте функцию громкоговорителя телевизора.

Эту функцию можно выбрать во время просмотра цифрового канала.
Появится аудиоформат в соответствии с транслируемым сигналом.

Описание аудио
Это вспомогательная функция аудио, которая обеспечивает дополнительную аудиодорожку для людей с ослабленным 
зрением. Эта функция обрабатывает аудиопоток для AD (описание аудио), когда он отправляется вещательной компанией 
вместе с основным аудио. Пользователи могут включить или выключить описание аудио и регулировать громкость.

Описание аудио → Выкл. / Вкл.
Используется для включения/выключения функции описания аудио.

Громкость
Можно настроить громкость описания аудио.

Громкость активен, если для параметра Описание аудио установлено значение Вкл..
Эту функцию можно выбрать во время просмотра цифрового канала.

Громкость авто → Выкл. / Вкл. 
Звук, транслируемый разными телевизионными станциями, имеет различные характеристики. По этой причине при каждом 
переключении канала приходится регулировать громкость, что не очень удобно. Данная функция позволяет выполнять 
автоматическое регулирование громкости звука канала, уменьшая ее в случае сильного модуляционного сигнала и 
увеличивая, если модуляционный сигнал слишком слабый.
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Режим	 : Польз.	 ▶

Эквалайзер
SRS TruSurround HD	 : Выкл.
Язык аудио  	 : ----
Аудиоформат  	 : ----
Описание аудио
Громкость авто	 : Выкл.
Выбрать громкогов.	 : Динамик ТВ

Звук
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Выбрать громкогов.
При просмотре телевизора с подключенным к нему домашним кинотеатром громкоговорители телевизора следует 
отключить, чтобы звук исходил из громкоговорителей (внешних) домашнего кинотеатра.

Внешний: используется для прослушивания звука с внешних громкоговорителей (домашнего кинотеатра).
Громкогов. ТВ: используется для прослушивания звука с громкоговорителей телевизора.
Кнопка регулировки громкости и кнопка MUTE не работают, если для параметра Выбрать громкогов. установлено 
значение Внешний.
Если выбран параметр Внешний в меню Выбрать громкогов., настройки звука будут ограничены.

Внутренние громкоговорители 
телевизора

Аудиовыход (оптический, выход Л/П) звуковой 
системы

RF / AV / Компонент / PC / HDMI RF / AV / Компонент / PC / HDMI
Динамик ТВ Выход громкоговорителя Вывод звука

Внешний громкогов. Отключение звука Вывод звука
Отсутствие видеосигнала Отключение звука Отключение звука

Выбор звука → Для всех режимов / Для текущего режима / Отмена
Можно восстановить заводские настройки по умолчанию для параметров звука.

Для текущего режима: будут восстановлены значения по умолчанию для текущих 
параметров звука.

Выбор режима звука
Режим звука можно настроить в меню Инструменты. При выборе параметра Dual l ll на экране отобразится текущий 
режим звука.

Тип звука Двойной 1/2 По умолчанию

A2 стерео
Моно Моно

Автоматическое изменение
Стерео Стерео ↔ Моно

Двойной ДВОЙНОЙ 1 ↔ ДВОЙНОЙ 2 ДВОЙНОЙ 1

NICAM 
стерео

Моно Моно
Автоматическое изменение

Стерео Моно ↔ Стерео

Двойной Моно ↔ ДВОЙНОЙ 1
ДВОЙНОЙ 2 ДВОЙНОЙ 1

Если стереосигнал слишком слабый и происходит автоматическое переключение режимов, выберите режим “Моно”.
Эта функция активизируется только для стереосигнала. При монофоническом сигнале она отключается.
Эта функция доступна только в режиме телевизора.
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Сброс звука  

 L Перем.     E Вход     R Возврат

Отмена сброса настроек звука.

Для всех режимов Для текущего режима Отмена
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НАСТРОЙКА

Меню настройки

Язык
Можно установить язык меню.

Время
Для получения подробных сведений о настройке параметров см. инструкции раздела 
«Установка времени».

Игровой режим → Выкл. / Вкл. 
При подключении игровой консоли, например PlayStation™ или Xbox™, можно выбрать меню игры для получения более 
реалистичных эффектов.

Ограничения для игрового режима (предупреждение)
Чтобы отсоединить игровую консоль и подключить другое внешнее устройство, в меню настройки установите для 
режима Игровой режим значение Выкл..
При отображении меню телевизора в режиме Игровой режим изображение на экране будет слегка дрожать.

Игровой режим недоступен в обычных режимах TV, PC и Ext.
Если при подключении к телевизору внешнего устройства качество изображения ухудшается, проверьте, не 
установлено ли для режима Игровой режим значение Вкл.. Установите для режима Игровой режим значение Выкл. 
и подсоедините внешние устройства.
Если режим Игровой режим включен:

Для режима изображения автоматически устанавливается значение Стандартный, которое невозможно изменить.
Режим звука автоматически изменяется на Польз., и его невозможно изменить. Отрегулируйте звук с помощью 
эквалайзера.
Включится функция сброса звука. Если после установки эквалайзера будет выбрана функция Сброс, то для 
эквалайзера будут восстановлены заводские настройки.

Замок → Выкл. / Вкл.
С помощью этой функции можно ограничить доступ определенных пользователей (например, детей) к неподходящим 
программам посредством отключение звука и изображения.

Перед отображением экрана настройки появится экран для ввода PIN-кода. Введите 4-значный PIN-код.
По умолчанию для телевизора используется PIN-код 0-0-0-0. Можно изменить PIN-код, выбрав в меню пункт 
Изменение PIN.
Некоторые каналы из списка каналов можно заблокировать.
Замок доступна только в режиме TV.

Изменение PIN  
Можно изменить персональный идентификационный номер, необходимый для установки телевизора.

Перед отображением экрана настройки появится экран для ввода PIN-кода. Введите 4-значный PIN-код.
По умолчанию для телевизора используется PIN-код 0-0-0-0.
Если вы забыли PIN-код, нажимайте кнопки пульта дистанционного управления в следующей последовательности для 
возвращения значения по умолчанию – 0-0-0-0: POWER (Выкл.) → MUTE → 8 → 2 → 4 → POWER (Вкл.).

Родит. блокировка → Родит. ограничения
С помощью этой функции можно ограничить доступ определенных пользователей (например, детей) к неподходящим 
программам с помощью 4-значного PIN-кода, определенного пользователем.

Настройки параметра Родит. ограничения зависят от страны, в которой используется устройство.
Перед отображением экрана настройки появится экран для ввода PIN-кода. Введите 4-значный PIN-код.
По умолчанию для телевизора используется PIN-код '0-0-0-0'. PIN-код можно изменить, выбрав в меню пункт 
Изменение PIN.
После установки родительских оценок отобразится символ '\'.
Разр. все: нажмите, чтобы снять блокировку всех оценок ТВ.
Блок.все: нажмите, чтобы заблокировать все оценки ТВ.

¦

❑

❑

❑

N
�

�
N
N

N
�
�

�

❑

N
N

N
N

❑

N
N
N

❑

N
N
N

N
N

Plug & Play

Язык	 : Русский	 ▶

Время
 Игровой режим  	 : Выкл.
Замок	 : Вкл.
Изменение PIN  
Родит. блокировка
Субтитры
Язык телетекста

Установка
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Субтитры
Субтитры можно включать и отключать. Это меню используется для настройки режима субтитров. Значение Норм. в этом 
меню соответствуют обычным субтитрам, а Расстр. слуха – субтитрам для людей с ослабленным слухом.

Субтитры → Выкл. / Вкл.
используется для включения или выключения субтитров.

Режим → Норм. / Расстр. слуха
используется для установки режима субтитров.

Язык субтитров  
используется для установки языка субтитров.

Если просматриваемая программа не поддерживает функцию Расстр. слуха, автоматически будет выбран режим 
Норм., даже если ранее был выбран режим Расстр. слуха.
Если выбранный язык не транслируется, по умолчанию устанавливается английский язык.
Эти параметры можно также установить, нажав кнопку SUBT. на пульте дистанционного управления.

Язык телетекста
Можно установить язык телетекста, выбрав тип языка.

Если выбранный язык не транслируется, по умолчанию устанавливается английский язык.

Предпочтение

Основной язык аудио / Вторичный язык аудио / Первичный язык субтитров / Вторичный язык субтитров / 
Основной язык телетекста / Вторичный язык телетекста
Используя эту функцию, пользователи могут выбрать один из языков. Выбранный язык используется по умолчанию, когда 
пользователь выбирает канал.
Если изменить настройку языка, то параметры Язык субтитров, Язык аудио и Язык телетекста меню Язык автоматически 
изменятся на выбранный язык.
В подменю Язык субтитров, Язык аудио и Язык телетекста в меню Язык отображается список языков, которые 
поддерживаются на текущем канале, а выбранные языки выделены цветом. При изменении этого параметра языка новый 
вариант действителен только для текущего канала. Измененный параметр не используется в подменю Первичный язык 
субтитров, Основной язык аудио или Основной язык телетекста   меню Предпочтение.

Цифровой текст → Отключить / Включить (только для Великобритании)
Эта функция включается, если программа передается с цифровым текстом.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
международный стандарт для систем кодирования данных, который используется для мультимедиа и гипермедиа. 
Это система более высокого уровня, чем MPEG и включает гипермедиа связанных данных, например неподвижные 
изображения, службу символов, анимацию, графические и видеофайлы, а также данные мультимедиа. MHEG – это 
технология интерактивной работы пользователя в реальном времени. Она применяется в различных областях, 
включая функции VOD (видео по запросу), ITV (интерактивное ТВ), EC (электронная коммерция), телеобучение, 
телеконференции, цифровые библиотеки и сетевые игры.

Мелодия → Выкл. / Низкий / Средний / Высокий
Можно установить мелодию, которая будет воспроизводиться при включении или выключении телевизора.

Мелодия не воспроизводится 
Когда звук не воспроизводится на телевизоре, поскольку нажата кнопка MUTE.
Когда звук не воспроизводится на телевизоре, поскольку с помощью кнопки регулировки громкости (-) громкость 
снижена до минимума.
Когда телевизор выключается с помощью функции таймера.

Экон. энергии → Выкл. / Низкий / Средний / Высокий / Авто
С помощью этой функции настраивается яркость телевизора для снижения потребления энергии. При просмотре 
телевизора в ночное время установите для параметра Экон. энергии значение Высокий, чтобы снизить утомляемость 
глаз, а также уменьшить потребление энергии.

Нажмите кнопку TOOLS для отображения меню Инструменты. Параметр Сбережение энергии можно также 
установить, выбрав Инструменты → Экон. энергии.
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Общий интерфейc

Меню CI  
Эта функция позволяет пользователям выбрать параметры в меню модуля CAM.
Выберите пункт CI Menu в меню платы PC Card.

Инфо о приложении.
Здесь приведены сведения о модуле CAM, подключенном к гнезду CI. Приложение отображает сведения о карте CI CARD. 
Можно установить CAM независимо от того, включен телевизор или нет.
1. 	 Можно приобрести модуль CI CAM, посетив ближайшего дилера, или по телефону.
2. 	 Вставьте карту CI CARD в модуль CAM в направлении, указанном стрелкой.
3.	 Вставьте модуль CAM с установленной картой CI CARD в гнездо стандартного интерфейса. 

(Вставьте модуль CAM в направлении, указанном стрелкой, до упора, так, чтобы модуль был параллелен гнезду.)
4. 	 Убедитесь, что на канале с зашифрованным сигналом можно видеть изображение.

❑
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Установка времени

Часы
Для использования различных функций таймера в телевизоре необходима установка 
часов.

Текущее время будет отображаться каждый раз при нажатии кнопки INFO.
После отключения кабеля питания часы потребуется установить заново.

Режим часов  
Можно установить текущее время вручную или автоматически.

Авто: установка текущего времени автоматически с использованием значения 
времени в цифровом вещании.
Ручной: установка текущего времени вручную.
В зависимости от телевизионной станции и сигнала автоматическое время может 
быть установлено неверно. В этом случае установите время вручную.
Для автоматической установки времени необходимо подключить антенну или кабель.

Установка часов
Можно установить текущее время вручную.

Эта функция доступна, только если для параметра Режим часов установлено значение Ручной.
Можно установить день, месяц, год, час и минуту с помощью цифровых кнопок на пульте дистанционного управления.

Таймер сна
Таймер сна автоматически выключает телевизор после определенного времени (30, 60, 90, 120, 150 и 180 минут).

Нажмите кнопку TOOLS для отображения меню Инструменты. Можно также установить функцию таймера сна, 
выбрав Инструменты → Таймер сна.
Для отмены функции Таймер сна выберите значение Выкл..

Таймер 1 / Таймер 2 / Таймер 3
Можно выполнить три различные настройки включения/отключения таймера.
Сначала необходимо установить часы.

Время вкл.
Установка часов, минут и включение / отключение.
(Чтобы включить таймер с выбранными параметрами, задайте значение Включить.)

Время выкл.
Установка часов, минут и включение / отключение.
(Чтобы включить таймер с выбранными параметрами, задайте значение Включить.)
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Часы	 :  -- : --	 	 ▶
Tаймер сна  	 : Выкл.
Таймер 1	 : Неактивный
Таймер 2	 : Неактивный
Таймер 3 	 : Неактивный	 	

U Перем.     E Вход     R Возврат

Время

Plug & Play
Язык	 : Русский

Время	 	 ▶

 Игровой режим  	 : Выкл.
Замок	 : Вкл.
Изменение PIN  
Родит. блокировка
Субтитры
Язык телетекста
Предпочтение

Установка

Время вкл.	

 U Перем.    U Настр.     E Вход     R Возврат

Таймер 1

Время выкл.

Громкость

00 00 Неактивный

00 00 Неактивный

10
Источн. Антенна Канал

ТВ ATV 0

Повтор
Один раз  

Вс Пн Втр Срд Чтв Пт Сб
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Громкость
Установка необходимого уровня громкости.

Источн. → ТВ / USB
При автоматическом включении ТВ или устройства USB можно выбрать содержимое для воспроизведения. Выберите ТВ 
или USB. (Убедитесь, что устройство USB подключено к телевизору).

Если в памяти USB находится только один файл фотографии, показ слайдов невозможен.

Антенна (когда для параметра Источн. установлено значение TB)
Выберите ATV или DTV.

Канал (когда для параметра Источн. установлено значение TB)
выбор необходимого канала.

Содержание (когда для параметра Источн. установлено значение USB)
При автоматическом включении телевизора на устройстве USB можно выбрать папку с музыкальными файлами или 
файлами фотографий.

Если имя папки слишком длинное, папку будет выбрать невозможно.
Если имя папки, которое требуется сконфигурировать с помощью функции Contents, слишком длинное, папку будет 
выбрать невозможно.

Повтор
Выберите Один раз, Ежедневно, Пн~Пт, Пн~Сб, Сб~Вс или Ручной.

При выборе параметра Ручной нажмите кнопку ► для выбора необходимого дня недели. Нажмите кнопку ENTERE, 
наведя курсор на нужный день, после чего отобразится значок c.
Можно также установить значение времени (часы и минуты) и канал с помощью цифровых кнопок на пульте 
дистанционного управления.
Автоматическое выключение питания
Когда включен таймер, телевизор выключится автоматически, если в течение 3 часов с момента включения 
телевизора таймером не было выполнено ни одной команды. Данная функция применяется, только когда таймер 
включен. Она предотвращает возможный перегрев телевизора при его продолжительной работе.
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ВХОДНОЙ СИГНАЛ/ПОДДЕРЖКА

Меню Вход

Список источников
Используется для выбора телевизора или других внешних источников ввода, например, 
DVD-проигрывателей/проигрывателей дисков Blu-ray/приемников кабельного/
спутникового телевидения (телеприставок), подключенных к телевизору. Используется для 
выбора нужного источника входного сигнала.

Нажмите кнопку SOURCE на пульте дистанционного управления для просмотра 
сигнала от внешнего источника. Режим телевизора можно выбрать с помощью кнопки 
TV, номерных кнопок (0~9) и кнопки P </> на пульте дистанционного управления.

TV / Ext.1 / Ext.2 / AV / Компонент / ПК / HDMI1 / HDMI2 / HDMI3/DVI / HDMI4
Можно выбрать только те внешние устройства, которые подключены к телевизору. 
В меню Список источников подключенные устройства входных сигналов будут 
выделены и будут отображаться вверху списка. Устройства входных сигналов, которые 
не подключены, будут отображаться внизу списка.
Использование цветных кнопок на пульте дистанционного управления со списком 
источников.

Красная (Обновить): обновление списка подключенных внешних устройств. 
Нажмите эту кнопку, если источник включен и подсоединен, но не отображается в 
списке.
TOOLS (Инструменты): отображение меню Редактир. назв. и Информация.

Редактир. назв.

VCR / DVD / Кабельное ТВ / Спутн.прист. / PVR / АV ресивер / Игра / Камера / ПК / DVI / DVI PC / TB / IPTV / Blu-ray / HD 
DVD / DMA
Укажите название устройства, подключенного к входным разъемам, для упрощения процедуры выбора источника.

Если к порту HDMI IN 3(DVI) подключен компьютер с разрешением 1920 x 1080 при частоте 60 Гц, необходимо выбрать 
для режима HDMI3/DVI значение DVI PC в поле Редактир. назв. режима Вход.

Meню поддержка

Самодиагностика

Тест изображения  
В случае возникновения проблемы с изображением выполните его тестирование. 
Проверьте цветовую схему на экране, чтобы посмотреть, устранена ли неполадка.

Да: если тестовый шаблон не отображается или при его отображении слышен шум, 
выберите Да. Возможно, неисправен телевизор. Поэтому обратитесь за поддержкой в 
операторский центр Samsung.
Нет: если тестовый шаблон отображается правильно, выберите Нет. Возможно, 
неисправно внешнее устройство. Проверьте подключения. Если неполадку не удается 
устранить, см. руководство пользователя, прилагаемое к внешнему устройству.

Звуковой тест 
В случае возникновения проблемы со звуком выполните его тестирование. Звук можно 
проверить, выполнив воспроизведение встроенной мелодии на телевизоре.

Если из громкоговорителей телевизора не слышен звук, то перед тестированием 
звука проверьте, не установлено ли для параметра Выбрать громкогов. значение Внешний в меню звука.
Мелодия будет слышна во время тестирования, даже если для параметра Выбрать громкогов. установлено значение 
Внешний или звук отключен путем нажатия кнопки MUTE.
Да: если во время тестирования звука, звук слышен только из одного громкоговорителя или не слышен совсем, 
выберите Да. Возможно, неисправен телевизор. Поэтому обратитесь за поддержкой в операторский центр Samsung.
Нет: если слышен звук из громкоговорителей, выберите Нет. Возможно, неисправно внешнее устройство. Проверьте 
подключения. Если неполадку не удается устранить, см. руководство пользователя, прилагаемое к внешнему 
устройству.
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Самодиагностика	 	 ▶

Обновл. ПО 
Руководство по соединению c ТВЧ
Обращение в Samsung

Поддержка

Список источников	 	

Редактир. назв.
Вход

   Обновить     T Инструменты

Список источников

ТВ

Ext. 1	 : - - - -
Ext. 2	 : - - - -
PC	 : - - - -

AV	 : - - - -
Компонент	 : - - - -

Самодиагностика

U Перем.     E Вход     R Возврат

Тест изображения	 	 	 ▶
Звуковой тест 
Информ. о сигнале
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Информ. о сигнале (только для цифровых каналов)
В отличие от аналоговых каналов, на которых изображение может быть разным от «снега» до четкого, цифровые каналы 
(HDTV) могут быть либо безупречного качества, либо совсем не приниматься. Поэтому в отличие от аналоговых каналов, 
точная настройка цифрового канала невозможна. Однако для улучшения качества приема доступных цифровых каналов 
можно отрегулировать антенну.

Если счетчик уровня сигнала свидетельствует о слабом сигнале, отрегулируйте антенну, чтобы увеличить уровень 
сигнала. Продолжайте регулировать антенну до тех пор, пока не будет найдено наилучшее положение для приема 
самого высокого уровня сигнала.

Обновл. ПО 
Компания Samsung может предлагать обновления для микропрограммы телевизора. Эти 
обновления можно выполнить на телевизоре, когда он подключен к Интернету, или путем 
загрузки новой микропрограммы с веб-узла samsung.com на устройство памяти USB.

Текущая версия – это программное обеспечение, уже установленное в телевизоре.
Альтернативное ПО (резервное) – показана предыдущая версия, которая будет 
заменена.
Программное обеспечение представлено в следующем формате: «год/месяц/
день_версия». Чем свежее дата, тем новее версия программного обеспечения. 
Рекомендуется установить самую последнюю версию.

По USB
Вставьте диск USB с обновлением микропрограммы, загруженным с веб-узла samsung.
com, в гнездо на телевизоре. Не отсоединяйте питание и не извлекайте диск USB, когда 
выполняется обновление. После завершения обновления микропрограммы телевизор 
автоматически выключится и снова включится. После выполнения обновления проверьте 
версию микропрограммы (у новой версии номер должен быть больше, чем у старой).
По завершении обновления для всех настроек видео и аудио будут восстановлены 
значения по умолчанию (заводские). Рекомендуется записывать свои настройки, чтобы их 
можно было легко восстановить после обновления.

По каналу
Обновление программного обеспечения через транслируемый сигнал.

Обновление в реж. ожидан.
Чтобы продолжить обновление программного обеспечения при включении основного питания, выберите пункт Вкл, нажав 
кнопку ▲ или ▼. Через 45 мин. после перехода в режим ожидания автоматически будет запущен мастер обновления 
вручную. Поскольку питание устройства включается автоматически, экран может слегка мигать. Этот эффект может 
продолжаться более 1 часа до тех пор, пока не будет завершено обновление программного обеспечения.

Альтернативное ПО (резервное копирование)
Если появились проблемы при использовании новой микропрограммы, можно вернуть предыдущую версию программного 
обеспечения.

Если программное обеспечение изменено, отобразится существующее программное обеспечение.
Можно сменить текущую программу на альтернативную, выбрав параметр Альтернативное ПО.

Руководство по соединению c ТВЧ
В этом меню представлен метод подключения, обеспечивающий оптимальное качество отображения на экране телевизора 
высокой четкости. Используйте данную информацию при подключении к телевизору внешних устройств.

Обращение в Samsung
Просмотрите данную информацию, когда телевизор работает неправильно или требуется обновить программное 
обеспечение. В этом меню представлена информация о центрах обслуживания клиентов, самом устройстве, а также о 
способах загрузки файла с программным обеспечением.
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Боковая панель телевизора

Диск USB

Текущая версия	 2009/01/18_000001

По USB	 	 	 ▶
По каналу
Обновление в реж. ожидан.	 : 45 Μин.	
Альтернативное ПО	 2009/01/15_000000

U Перем.     E Вход     R Возврат

Обновл. ПО 
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Media Play (USB)

Подключение устройства USB

1.	 Нажмите кнопку ПИТАНИЕ, чтобы включить телевизор.
2.	 Подсоедините устройство USB, содержащее файлы фотографий и/или музыкальные 

файлы к гнезду USB  на боковой панели телевизора.
3.	 При отображении экрана выбора Приложение нажмите кнопку ENTERE, чтобы 

выбрать пункт Media Play (USB).
Протокол MTP (Media Transfer Protocol) не поддерживается.
Поддерживаются файловые системы FAT16, FAT32 и NTFS.
Определенные типы цифровых камер USB и аудиоустройств могут быть 
несовместимы с этим телевизором.
Media Play поддерживает только устройства USB MSC (Mass Storage 
Class). MSC – это устройства Mass Storage Class с возможностью 
передачи единым целым. Примерами устройств MSC являются 
флэш-диски, устройства чтения флэш-карт и жесткие диски USB (не 
поддерживаются концентраторы USB). 
Подсоедините непосредственно к порту USB телевизора. Если 
используется отдельное кабельное подключение, может возникнуть 
проблема совместимости USB.
Перед подключением устройства к телевизору создайте резервные копии 
файлов, чтобы предотвратить повреждение или потерю данных. Компания SAMSUNG не несет ответственности за 
любые повреждения файлов или потерю данных.
Не отключайте устройство USB во время загрузки.
Устройства MSC поддерживают файлы в формате MP3 и JPEG, устройства PTP – только JPEG.
Чем больше разрешение изображения, тем больше времени требуется для его отображения на экране.
Максимально возможное разрешение JPEG – 15360 X 8640 пикселей.
Если файл поврежден или имеет несовместимый формат, отображается сообщение «Формат файла не поддерж».
Файлы MP3 с технологией DRM, которые были загружены с платного узла, невозможно воспроизвести. Digital 
Rights Management (DRM) – это технология, которая поддерживает создание содержимого, распространение и 
полное интегрированное управление содержимым, включая защиту прав и интересов поставщиков содержимого, 
предотвращение незаконного копирования содержимого, а также управление выставлением счетов и платежами.
При переходе к фотографии может потребоваться несколько секунд для загрузки. В этом случае на экране 
появляется значок загрузки. 
Если подключено несколько устройств MSC, возможно, некоторые из них не будут распознаваться. Если 
для работы устройства требуется большая мощность (более 500 мА или 5 В), устройство USB, возможно, 
поддерживаться не будет. 
Если во время подключения или использования устройства USB отобразится предупреждающее сообщение о 
превышении мощности, возможно, устройство не распознается или неисправно.

Использование кнопок пульта дистанционного управления в меню Media Play
Кнопка Функция

▲/▼/◄/► Перемещение курсора для выбора элемента.

ENTERE

Выбор элемента, на который наведен курсор. При воспроизведении слайд-шоу или 
музыкального файла:
- с помощью кнопки ENTERE можно приостановить воспроизведение.
- с помощью кнопки ENTERE можно возобновить воспроизведение после паузы.

∂/∑ Воспроизведение или приостановка слайд-шоу, музыки.
Возврат Возврат к предыдущему меню.
TOOLS Запуск различных функций из меню Фото и Музыка.

∫ Завершение воспроизведения текущего слайд-шоу или музыкального файла.
π/μ Переход к предыдущей группе/переход к следующей группе.

INFO Отображение сведений о файле.
MEDIA.P Выход из режима Media Play.

< P >, EXIT, TV Выключение режима Media Play и возврат в режим TV.
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Боковая панель телевизора

Диск USB

851.86MB/993.02MB Своб.

Photo

SUM

SUM   Устройс.

PHOTO

R Возврат

Music Setup
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Функция Media Play
Данная функция позволяет просматривать и воспроизводить файлы фотографий и/или музыкальные файлы, хранящиеся 
на устройстве USB MSC (Mass Storage Class).

Вход в меню Media Play (USB)
1.	 Нажмите кнопку MENU. С помощью кнопки ▲ или ▼ выберите пункт 

Приложение, затем нажмите кнопку ENTERE.

2.	 С помощью кнопки ▲ или ▼ выберите Media Play (USB), затем нажмите 
кнопку ENTERE.

Отобразится меню Media Play (USB).

Нажмите кнопку MEDIA.P на пульте дистанционного управления, чтобы 
открыть меню Media Play.

Нажмите кнопку SOURCE на пульте дистанционного управления для 
просмотра списка источников. Затем нажмите кнопку ▲ или ▼ для 
выбора пункта USB.

3.	 Нажмите красную кнопку, затем нажмите кнопку ▲ или ▼, чтобы выбрать 
память устройства USB. Нажмите кнопку ENTERE.

Эта функция изменяется в зависимости от устройства памяти USB.
В левой нижней части экрана отобразится имя выбранного устройства 
USB.

4.	 С помощью кнопки ◄ или ► выберите значок (Photo, Music, Setup), затем 
нажмите кнопку ENTERE. 
Чтобы выйти из режима Media Play, нажмите кнопку MEDIA.P на пульте 
дистанционного управления.

Безопасное отключение запоминающего устройства USB
Безопасное отключение устройства от телевизора.
1.	 Нажмите кнопку TOOLS на экране списка файлов Media Play или во время воспроизведения слайд-шоу или 

музыкального файла.
2.	 С помощью кнопки ▲ или ▼ выберите Безопасное отключение, затем нажмите кнопку ENTERE.
3.	 Отключите устройство USB от телевизора.

Отображение на экране

С помощью кнопок со стрелками вверх или вниз перейдите к разделу списка групп или к разделу списка файлов. Выбрав 
раздел, с помощью кнопки ◄ или ► выберите пункт.
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1	 Просмотр групп: Отсортированная группа, в которой содержится выбранный в данный момент файл, выделяется.
2	 Выбранный в данный момент файл: это файл, которым можно управлять в данный момент. Файлы фотографий 

отобразятся в виде эскизов.
3	 Текущее устройство: отображение имени устройства, выбранного в настоящий момент. Выбрать устройство можно с 

помощью красной кнопки.
Красная кнопка (Устр.): выбор подсоединенного устройства.

4	 Сведения о выборе элементов: отображение количества файлов, выбранных с помощью желтой кнопки.
5	 Вспомогательные элементы

Желтая кнопка (Выбрать): выбор файла из списка. Выбранные файлы отмечаются значком c. Чтобы отменить 
выбор, еще раз нажмите желтую кнопку.
TOOLS (Инструменты): отображение меню параметров (вид меню параметров зависит от текущего состояния).

Меню параметров списка фотографий

1.	 Нажмите кнопку MEDIA.P.
2.	 Нажмите кнопку ◄ или ► для выбора пункта Photo, затем нажмите кнопку 

ENTERE. 
3.	 Нажмите кнопку ▼ для перехода к разделу списка файлов.
4.	 С помощью кнопки ◄ или ► выберите необходимый фотофайл.

Выбор нескольких фотографий
С помощью кнопки ◄ или ► выберите необходимый фотофайл. 
Затем нажмите желтую кнопку.
Повторите описанную выше операцию, чтобы выбрать несколько 
файлов фотографий.
Рядом с выбранным файлом фотографии появится значок c.

5.	 Нажмите кнопку TOOLS.
Вид меню параметров зависит от текущего состояния.

Показ слайдов
Воспроизведение слайд-шоу, составленного из фотофайлов запоминающего устройства USB.

Воспр. текущ. гр.
Воспроизведение слайд-шоу, составленного из файлов фотографий текущей отсортированной группы.

Отменить все (если выбран хотя бы один файл)
Можно отменить выбор всех файлов.

Значок c, свидетельствующий о том, что соответствующий файл выбран, будет скрыт.

Информация
Отображение сведений о файле фотографии, включая его имя, размер, разрешение, дату изменения и путь.

Информацию о файлах фотографий во время слайд-шоу можно просматривать с помощью аналогичной процедуры.
Для просмотра информации нажмите кнопку INFO. 

Безопасное отключение
Безопасное отключение устройства от телевизора.
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Просмотр фотографии или слайд-шоу

Просмотр слайд-шоу
1.	 С помощью кнопки ▼ выберите раздел списка файлов.

2.	 Нажмите кнопку TOOLS.

3.	 С помощью кнопки ▲ или ▼ выберите пункт Слайд-шоу, затем нажмите 
кнопку ENTERE.

Все файлы из списка фотографий будут включены в слайд-шоу.

Во время слайд-шоу будут отображаться файлы из текущей папки по 
порядку.
Слайды будут отображаться в том порядке, в каком они перечислены в 
списке фотографий.

Музыкальные файлы будут автоматически воспроизводиться во время 
слайд-шоу, если для параметра Фоновая музыка установлено значение 
Вкл. 

Когда отображается список фотографий, нажмите кнопку 
∂(Воспроизведение)/ENTERE на пульте дистанционного управления, 
чтобы начать показ слайдов.

Кнопки управления слайд-шоу
Кнопка Функция

ENTERE Воспроизведение/приостановка слайд-шоу.
∂ Воспроизведение слайд-шоу.
∑ Приостановка слайд-шоу.

∫
Выход из режима воспроизведения слайд-шоу и 
возврат к списку фотографий.

π/μ Изменение скорости слайд-шоу.
TOOLS Запуск различных функций в меню фотографий.

Воспроизведение текущей группы
1.	 Нажмите кнопку ▲ для перехода к разделу списка групп.
2.	 С помощью кнопок ◄ и ► выберите группу. 
3.	 Нажмите кнопку ∂ (воспроизведение). Начнется воспроизведение слайд-

шоу с файлов выбранной группы.

Альтернативный вариант 
1.	 Выберите файлы в разделе списка файлов, содержащиеся в нужной группе.

Для перехода к предыдущей/следующей группе используйте кнопку π 
(REW) или µ (FF).

2.	 Нажмите кнопку TOOLS. 
3.	 С помощью кнопки ▲ или ▼ выберите пункт Воспр. текущ. гр., затем нажмите кнопку ENTERE.

В слайд-шоу будут включены только фотографии из отсортированной группы, включая выделенные файлы.

Показ слайд-шоу, состоящего только из выбранных файлов
1.	 С помощью кнопки ▼ выберите раздел списка файлов.
2.	 С помощью кнопки ◄ или ► выберите нужную фотографию в списке фотографий.
3.	 Нажмите желтую кнопку.
4.	 Повторите описанную выше операцию, чтобы выбрать несколько фотографий.

Слева от выбранной фотографии появится значок c.
Если выбрать только один файл, слад-шоу воспроизводиться не будет.
Чтобы отменить выбор всех файлов, нажмите кнопку TOOLS и выберите пункт Отменить все.

5.	 Нажмите кнопку ∂ (воспроизведение)/ENTERE.
Выбранные файлы будут включены в слайд-шоу.
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Альтернативный вариант 
1.	 С помощью желтых кнопок в списке фотографий выберите нужные фотографии.
2.	 Нажмите кнопку TOOLS. 
3.	 С помощью кнопки ▲ или ▼ выберите пункт Слайд-шоу, затем нажмите кнопку ENTERE.

Выбранные файлы будут включены в слайд-шоу.

Меню параметров слайд-шоу

1.	 Во время слайд-шоу (или просмотра фотографии) нажмите кнопку TOOLS, 
чтобы установить параметр.

2.	 С помощью кнопки ▲ или ▼ выберите параметр, затем нажмите кнопку 
ENTERE.

Остановка показа / Запустить показ слайдов
Запуск или остановка слайд-шоу.

Скор. слайд-шоу → Медленная / Норм. / Быстрая
Выбор скорости слайд-шоу.

Данная функция доступна только во время слайд-шоу.
Можно также изменить скорость слайд-шоу, нажав кнопку π (REW) или µ (FF) во время слайд-шоу.

Повернуть
Поворот фотографий, хранящихся на запоминающем устройстве USB.

При каждом нажатии кнопки ◄ фотография поворачивается на 270°, 180°, 90° и 0°.
При каждом нажатии кнопки ► фотография поворачивается на 90°, 180°, 270° и 0°. 
Повернутый файл не сохраняется.

Увел.
Увеличение фотографий, хранящихся на запоминающем устройстве USB. (x1 → x2 → x4)

Чтобы переместить увеличенное изображение, нажмите кнопку ENTERE, а затем одну из кнопок ▲/▼/◄/►. 
Обратите внимание, что если увеличенная фотография не превышает размер экрана, то функция перемещения 
недоступна.
Увеличенное изображение не сохраняется.

Фоновая музыка
Выбор фоновой музыки для просмотра слайд-шоу.

Этой функцией можно воспользоваться, только если на устройстве USB хранятся музыкальные файлы и файлы 
фотографий.

Фоновая музыка → Выкл / Вкл 
Выкл.: фоновая музыка не воспроизводится.
Вкл: если фоновая музыка доступна, то при выборе значения Вкл музыка будет воспроизводиться. 

Выбор файла музыки (0 Выбр.файлы)
Только выбранный музыкальный файл будет установлен в качестве фоновой музыки.

Настройка изображения / Настройка звука
Выбор настроек изображения и звука.

Информация
Отображение сведений о файле фотографии.

Безопасное отключение
Безопасное отключение устройства от телевизора.
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Меню параметров списка музыки

1.	 Нажмите кнопку MEDIA.P.
2.	 Нажмите кнопку ◄ или ► для выбора пункта Music, затем нажмите кнопку 

ENTERE. 
3.	 Нажмите кнопку ▲ для перехода к разделу списка файлов.
4.	 С помощью кнопки ◄ или ► выберите необходимый музыкальный файл. 

Выбор нескольких музыкальных файлов
С помощью кнопки ◄ или ► выберите нужный музыкальный файл. 
Затем нажмите желтую кнопку.
Повторите описанную выше операцию, чтобы выбрать несколько 
музыкальных файлов.
Рядом с выбранным музыкальным файлом появится значок c.

5.	 Нажмите кнопку TOOLS.
Вид меню параметров зависит от текущего состояния.

Воспр. текущ. гр.
Воспроизведение музыкальных файлов только из текущей отсортированной группы.

Отменить все (если выбран хотя бы один файл)
Можно отменить выбор всех файлов.

Значок c, свидетельствующий о том, что соответствующий файл выбран, будет скрыт.

Информация
Отображение информации о музыкальном файле, включая имя, размер, дату изменения и путь к файлу.

Можно просмотреть сведения о музыкальном файле в режиме Воспр. текущ. гр., используя те же самые процедуры.
Для просмотра информации нажмите кнопку INFO. 

Безопасное отключение
Безопасное отключение устройства от телевизора.
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Воспроизведение музыки

Воспроизведение музыкального файла
1.	 С помощью кнопки ▼ выберите раздел списка файлов.
2.	 С помощью кнопки ◄ или ► выберите музыкальный файл для 

воспроизведения.
3.	 Нажмите кнопку ∂ (воспроизведение)/ENTERE.

В этом меню отображаются только файлы с расширением MP3. Файлы 
с другими расширениями не отображаются, даже если они хранятся на 
том же самом устройстве USB.
Выбранный файл и время его воспроизведения отображается в верхней 
части экрана.
Для регулировки громкости музыки используйте кнопки громкости на пульте дистанционного управления. Для 
отключения звука нажмите кнопку MUTE на пульте дистанционного управления.
Если при воспроизведении файлов MP3 слышен странный звук, настройте параметры Эквалайзер и SRS 
TruSurround HD в меню Звук. (при воспроизведении перемодулированного файла MP3 могут возникнуть 
проблемы со звуком).
Продолжительность воспроизведения музыкального файла может отображаться как «00:00:00», если в начале 
файла не найдены данные о времени воспроизведения.
π (REW) и µ (FF) не работают.

Кнопки управления воспроизведением музыки
Кнопка Функция

ENTERE Воспроизведение/приостановка воспроизведения музыкального файла.
∂ Воспроизведение музыкального файла.
∑ Приостановка воспроизведения музыкального файла.
∫ Выход из режима воспроизведения и возврат к списку музыки.

TOOLS Запуск различных функций в меню музыки.

Значки типов воспроизведения музыки

p
Повторное воспроизведение всех музыкальных файлов в папке (или выбранного файла). 
Режим повтора установлено значение Вкл.

q
Однократное воспроизведение всех музыкальных файлов в папке (или выбранного 
файла). Режим повтора установлено значение Выкл.

Воспроизведение музыкальной группы
1.	 Нажмите кнопку ▲ для перехода к разделу списка групп.
2.	 С помощью кнопок ◄ и ► выберите группу.
3.	 Нажмите кнопку ∂ (воспроизведение). Начнется воспроизведение файлов выбранной группы.

Альтернативный вариант 
1.	 Выберите файлы в разделе списка файлов, содержащиеся в нужной группе.

Для перехода к предыдущей/следующей группе используйте кнопку π (REW) или µ (FF).
2.	 Нажмите кнопку TOOLS. 
3.	 С помощью кнопки ▲ или ▼ выберите пункт Воспр. текущ. гр., затем нажмите кнопку ENTERE.

Будут воспроизведены все музыкальные файлы отсортированной группы, включая выбранный файл.

Воспроизведение выбранных музыкальных файлов
1.	 С помощью кнопки ▼ выберите раздел списка файлов.
2.	 С помощью кнопки ◄ или ► выберите необходимый музыкальный файл.
3.	 Повторите описанную выше операцию, чтобы выбрать несколько музыкальных файлов.

Слева от выбранного музыкального файла появится значок c.
Чтобы отменить выбор всех файлов, нажмите кнопку TOOLS и выберите пункт Отменить все.

4.	 Нажмите кнопку ∂ (воспроизведение)/ENTERE.
Выбранные файлы будут воспроизведены.
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Меню параметров воспроизведения музыки

Меню параметров воспроизведения музыки

Режим повтора → Вкл / Выкл
Повторное воспроизведение музыкальных файлов.

Настройка изображения / Настройка звука
Выбор настроек изображения и звука.

Информация
Отображение сведений о музыкальном файле.

Безопасное отключение
Безопасное отключение устройства от телевизора.
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Использование меню Установка
В меню Setup отображаются пользовательские настройки меню Media Play.
1.	 Нажмите кнопку MEDIA.P.
2.	 С помощью кнопки ◄ или ► выберите пункт Setup, затем нажмите кнопку 

ENTERE.
3.	 С помощью кнопки ▲ или ▼ выберите необходимый параметр.
4.	 С помощью кнопки ◄ или ► выберите параметр, затем нажмите кнопку 

ENTERE .
Чтобы выйти из режима Media Play, нажмите кнопку MEDIA.P на пульте 
дистанционного управления.

Режим повтора → Вкл / Выкл
Повторное воспроизведение музыкальных файлов.

Время заставки → 2 часа / 4 часов / 8 часов
Выберите, чтобы задать время ожидания перед отображением экранной заставки.

Информация
Выберите для просмотра информации о подключенном устройстве.

Безопасное отключение
Безопасное отключение устройства от телевизора.
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ANYNET+

Подключение устройств Anynet+

Что такое Anynet+?
Anynet+ – это функция, позволяющая с помощью пульта дистанционного управления для телевизора управлять всеми 
подключенными устройствами Samsung, поддерживающими функцию Anynet+. Систему Anynet+ можно использовать 
только с устройствами Samsung, поддерживающими функцию Anynet+. Чтобы узнать, поддерживает ли ваше устройство 
Samsung эту функцию, проверьте, есть ли на устройстве значок Anynet+.

Подключение к телевизору

1.	 С помощью кабеля HDMI соедините гнездо HDMI IN (1, 2, 3(DVI) или 4) на телевизоре с гнездом HDMI OUT на 
соответствующем устройстве, поддерживающем функцию Anynet+.

Подключение к домашнему кинотеатру

1.	 С помощью кабеля HDMI соедините гнездо HDMI IN (1, 2, 3(DVI) или 4) на телевизоре с гнездом HDMI OUT на 
соответствующем устройстве, поддерживающем функцию Anynet+.

2.	 С помощью кабеля HDMI соедините гнездо HDMI IN домашнего кинотеатра и гнездо HDMI OUT соответствующего 
устройства, поддерживающего функцию Anynet+.

Подсоедините оптический кабель между гнездом DIGITAL AUDIO OUT (OPTICAL) на телевизоре и цифровым 
аудиовходом на домашнем кинотеатре.
После подсоединения кабелей, как описано выше, через гнездо для оптического кабеля выполняется вывод 
только двухканального звука. Звук будет слышен только через передний правый и левый громкоговорители, а 
также через сабвуфер домашнего кинотеатра. Если требуется 5,1-канальный звук, подключите гнездо DIGITAL 
AUDIO OUT (OPTICAL) на проигрывателе DVD-дисков/декодере кабельного/спутникового телевидения (т.е. 
устройстве Anynet 1 или 2) непосредственно к усилителю или домашнему кинотеатру, а не к телевизору.
Подключайте только один домашний кинотеатр.
Устройство Anynet+ можно подключить с помощью кабеля HDMI 1.3. Некоторые кабели HDMI могут не 
поддерживать функции Anynet+.
Функция Anynet+ работает, когда аудиоустройство, поддерживающее Anynet+, находится в режиме ожидания или 
включено.
Anynet+ поддерживает до 12 аудиоустройств. Можно подключить максимум 3 устройства одного типа.
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ТВ

Устройство Anynet+ 1

Кабель HDMI 1.3

Кабель HDMI 1.3
Кабель HDMI 1.3Кабель HDMI 1.3

ТВ

Кабель HDMI 1.3
Оптический кабель

Устройство Anynet+ 2 Устройство Anynet+ 3 Устройство Anynet+ 4

Домашний кинотеатр
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Настройка Anynet+

Нажмите кнопку TOOLS для отображения меню Инструменты. Можно также 
отобразить меню Anynet+, выбрав Инструменты → Anynet+ (HDMI-CEC).

Установка

Anynet+ (HDMI-CEC) → Выкл / Вкл
Чтобы использовать функцию Anynet+, необходимо установить для параметра Anynet+ 
(HDMI-CEC) значение Вкл.

Когда функция Anynet+ (HDMI-CEC) отключена, все операции, связанные с Anynet+, 
деактивируются.

Автоотключение →  Нет / Да
Настройка устройства Anynet+ на автоматическое выключение при выключении 
телевизора.

Для использования функции Anynet+ на пульте дистанционного управления для 
телевизора в качестве активного источника необходимо выбрать телевизор.
Если для параметра Автоотключение выбрано значение Да, подключенные внешние 
устройства будут отключаться при выключении телевизора. Можно выбрать, должно 
ли внешнее устройство, находящееся в режиме записи, выключаться.

Переключение между устройствами, поддерживающими функцию Anynet+

1.	 Нажмите кнопку TOOLS. Нажмите кнопку ENTERE, чтобы выбрать пункт Anynet+ 
(HDMI-CEC).

2. 	 С помощью кнопки ▲ или ▼ выберите пункт Список устройств, затем нажмите 
кнопку ENTERE.

Отобразится список устройств Anynet+, подключенных к телевизору.
Если не удается найти необходимое устройство, нажмите красную кнопку, чтобы 
начать сканирование устройств. 

3.	 Нажмите кнопку ▲ или ▼, чтобы выбрать необходимое устройство, а затем нажмите 
кнопку ENTERE. Будет выбрано соответствующее устройство.

Только при установке для функции Anynet+ (HDMI-CEC) значения Вкл в меню 
Приложение можно отобразить меню Список устройств.

Переключение на выбранное устройство может занять до 2 минут. Операцию переключения нельзя отменить во время 
ее выполнения.
Время, необходимое для сканирования устройств, зависит от количества подключенных устройств.
По завершении сканирования устройств количество найденных устройств не отображается.
Несмотря на то, что телевизор при включении (кнопка питания) автоматически производит поиск списка устройств, 
устройства, подключенные к телевизору могут не всегда автоматически отображаться в списке устройств при 
включении телевизора. Нажмите красную кнопку, чтобы выполнить поиск подключенных устройств.
При выборе режима внешнего ввода с помощью кнопки SOURCE функцию Anynet+ нельзя использовать. Убедитесь, 
что выбрано устройство Anynet+, воспользовавшись списком Список устройств.

Меню Anynet+
Меню Anynet+ изменяется в зависимости от типа и состояния устройств Anynet+, подключенных к телевизору.

Меню Anynet+ Описание
Просмотр ТВ Переключение из режима Anynet+ в режим ТВ-трансляции.
Список устройств Отображение списка устройств Anynet+.

(имя_устройства) Menu
Отображение меню подключенных устройств. Например: если подключено 
устройство записи DVD-дисков, отобразится меню диска в устройстве записи 
DVD-дисков.

(имя_устройства) INFO
Отображение меню воспроизведения подключенного устройства. Например: 
если подключено устройство записи DVD-дисков, отобразится меню 
воспроизведения диска в устройстве записи DVD-дисков.

Запись: (*устройство записи) Немедленное начало записи с помощью устройства записи. (Функция записи 
доступна, только если ее поддерживают устройства.)

Остановить запись: 
(*устройство записи) Остановка записи.

Pесивер Звук воспроизводится через приемник.

Если подключено несколько устройств записи, они отображаются как (*устройство записи), если подключено только 
одно устройство записи, оно будет отображаться как (*имя_устройства).
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U Перем.     E Вход     R Возврат

Anynet+ (HDMI-CEC)	 : Вкл.	                            ▶

Установка

Автоотключение	 : Да

Media Play (USB)

Anynet+ (HDMI-CEC)	

Приложение

U Перем.     E Вход     R Возврат

Anynet+ (HDMI-CEC)	 : Вкл.

Установка

Автоотключение	 : Да                               ▶

U Перем.     E Вход     R Возврат

Просмотр ТВ
Список устройств
Запись: DVDR
DVDR MENU
DVDR INFO
Pесивер: Выкл.
Установка
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Кнопки пульта управления телевизора, доступные в режиме Anynet+

Тип устройства Рабочее состояние Доступные кнопки

Устройство 
Anynet+

После выбора устройства, когда 
на экране отображается меню 
соответствующего устройства.

Цифровые кнопки
Кнопки ▲/▼/◄/►/прокрутка/ ENTERE
Цветные кнопки/кнопка EXIT

После выбора устройства при 
воспроизведении файла

π(поиск в обратном направлении)/µ(поиск 
вперед)/∫(остановка)/∂(воспроизведение)/
∑(пауза)

Устройство со 
встроенным 
тюнером

После выбора устройства во время 
просмотра телепрограммы P >/P <

Аудиоустройство Когда включен приемник Y/MUTE
Функция Anynet+ работает только в том случае, если на пульте дистанционного управления в качестве активного 
источника выбран телевизор.
Кнопка ∏ активна только в режиме записи.
Устройствами Anynet+ нельзя управлять с помощью кнопок на телевизоре. Устройствами Anynet+ можно управлять 
только с помощью пульта дистанционного управления телевизора.
Пульт дистанционного управления телевизора может не работать в определенных условиях. В этом случае повторно 
выберите устройство, поддерживающее функцию Anynet+.
Функции Anynet+ не доступны на устройствах других производителей.
Функции π, µ на разных устройствах могут различаться.

Запись
С помощью устройства для записи Samsung можно записывать телевизионные 
программы.
1.	 Нажмите кнопку TOOLS. Нажмите кнопку ENTERE, чтобы выбрать пункт Anynet+ 

(HDMI-CEC).
2.	 Нажмите кнопку ▲ или ▼, чтобы выбрать немедленную запись, затем нажмите 

кнопку ENTERE. Начнется запись.
Если используется несколько записывающих устройств
При подключении нескольких записывающих устройств эти устройства 
отображаются в списке. Нажмите кнопку ▲ или ▼, чтобы выбрать устройство 
записи, затем нажмите кнопку ENTERE. Начнется запись.
Если устройство записи не отображается, выберите Список устройств и нажмите красную кнопку, чтобы 
выполнить поиск устройств.

3. 	 Чтобы выйти, нажмите кнопку EXIT.
Можно записывать потоки источников, выбрав пункт Запись: (имя_устройства).
При нажатии кнопки ∏ начнется запись того, что воспроизводится на экране. При просмотре видео с другого 
устройства будет выполнена запись видео с этого устройства.
Перед записью проверьте, правильно ли выполнено подключение к гнезду антенны на записывающем устройстве. 
Для правильного подключения антенны к устройству записи см. руководство пользователя к устройству записи.

Прослушивание через ресивер (домашний кинотеатр)
Вместо громкоговорителей телевизора звук можно прослушивать через приемник.
1.	 Нажмите кнопку TOOLS. Нажмите кнопку ENTERE, чтобы выбрать пункт Anynet+ 

(HDMI-CEC).
2. 	 Нажмите кнопку ▲ или ▼, чтобы выбрать пункт Pесивер. Нажмите кнопку ◄ или ► 

для выбора пункта Вкл или Выкл.
3. 	 Чтобы выйти, нажмите кнопку EXIT.

Если используемый приемник поддерживает только аудио, он может не 
отображаться в списке устройств.
Приемник будет работать при правильном подключении оптического гнезда на 
приемнике к гнезду DIGITAL AUDIO OUT (OPTICAL) на телевизоре.
Если для приемника (домашний кинотеатр) установлено значение Вкл, звук будет слышен из выходного гнезда 
для оптического соединения телевизора. Если для телевещания используется сигнал цифрового ТВ (по воздуху), 
то звук будет воспроизводиться по 5,1-канальной системе приемника домашнего кинотеатра. Если в качестве 
источника используется цифровое устройство, например DVD-проигрыватель, подключенный к телевизору с 
помощью кабеля HDMI, воспроизведение звука возможно только по 2- канальной системе приемника домашнего 
кинотеатра.
При отключении питания телевизора, когда для параметра Receiver установлено значение Вкл (путем 
отсоединения кабеля питания или при нарушении энергоснабжения), при повторном включении телевизора для 
параметра Выбрать громкогов. может быть установлено значение Внеш. громк..
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U Перем.     E Вход     R Возврат

Просмотр ТВ
Список устройств
Запись: DVDR
DVDR MENU
DVDR INFO
Pесивер: Выкл.
Установка

U Перем.     E Вход     R Возврат

Просмотр ТВ
Список устройств
Запись: DVDR
DVDR MENU
DVDR INFO
Pесивер: Выкл.
Установка
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Поиск и устранение неисправностей Anynet+

Неисправность Способ устранения
Не работает функция 
Anynet+.

Проверьте, поддерживает ли устройство функцию Anynet+. Система Anynet+ поддерживает 
только устройства Anynet+.
Подключайте только один ресивер (домашний кинотеатр).
Проверьте правильность подключения кабеля питания устройства Anynet+.
Проверьте подключения видео-/аудио-/HDMI-кабелей 1.3-канальной системы устройства 
Anynet+.
Убедитесь, что для параметра Anynet+ (HDMI-CEC) установлено значение On в меню 
настройки Anynet+.
Убедитесь, что пульт дистанционного управления находится в режиме работы с 
телевизором.
Убедитесь, что используется пульт дистанционного управления с поддержкой функции 
Anynet+.
В некоторых случаях функция Anynet+ не работает. (Поиск каналов, использование 
функций Media Play, Plug & Play и т.д.)
При подключении или отключении кабеля HDMI 1.3 выполните повторный поиск устройств 
или выключите и включите телевизор снова.
Убедитесь, что для функции Anynet+ устройства Anynet+ установлено значение включения.

●

●
●
●

●

●

●

●

●

●
Необходимо запустить 
Anynet+.

Проверьте правильность подключения устройства Anynet+ к телевизору, а также 
убедитесь, что для параметра Anynet+ (HDMI-CEC) установлено значение Вкл в меню 
Anynet+ Установка.
Нажмите кнопку TV на пульте дистанционного управления телевизора, чтобы выбрать 
телевизор. После этого нажмите кнопку TOOLS для отображения меню Anynet+ и 
выберите необходимое меню.

●

●

Необходимо выйти из 
системы Anynet+.

Выберите пункт Просмотр ТВ в меню Anynet+.
Нажмите кнопку SOURCE на пульте дистанционного управления телевизора и выберите 
устройство, отличное от устройств Anynet+.
Для изменения режима телевизора используйте кнопки P >/<, PRE-CH и FAV.CH. 
(Обратите внимание, что кнопка канала работает только в том случае, если не подключено 
устройство Anynet+ со встроенным тюнером.)

●
●

●

На экране отобразится 
сообщение 
«Подключение к 
устройству Anynet+».

Пульт дистанционного управления нельзя использовать при настройке Anynet+ или 
переходе в режим просмотра.
Используйте пульт дистанционного управления после настройки Anynet+ или перехода в 
режим просмотра.

●

●

Устройство Anynet+ 
не выполняет 
воспроизведение.

Эту функцию невозможно использовать одновременно с функцией Plug & Play.●

Подключенное 
устройство не 
отображается.

Проверьте, поддерживает ли устройство функции Anynet+.
Проверьте правильность подсоединения кабеля HDMI 1.3.
Убедитесь, что для параметра Anynet+ (HDMI-CEC) установлено значение Вкл в меню 
настройки Anynet+.
Повторите поиск устройств Anynet+.
Устройство Anynet+ можно подключить только с помощью кабеля HDMI 1.3. Некоторые 
кабели HDMI могут не поддерживать функции Anynet+.
Если питание отключается в непредвиденной ситуации, например при отключении кабеля 
HDMI или кабеля питания, либо в результате нарушения энергоснабжения, повторно 
выполните сканирование устройств.

●
●
●

●
●

●

Невозможно выполнить 
запись телевизионных 
программ.

Проверьте, правильно ли выполнено подключение к гнезду антенны на записывающем 
устройстве.

●

Звуковые 
телевизионные сигналы 
не выводятся через 
приемник.

Подключите приемник к телевизору с помощью оптического кабеля.●

¦
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РЕКОМЕНДАЦИИ

Функция телетекста
Большинство телевизионных станций предлагают для просмотра текстовую информацию через услугу телетекста. 
Информацию об использовании услуги телетекста можно найти на главной странице службы телетекста. К тому же, при 
помощи кнопок пульта дистанционного управления можно выбрать различные параметры настроек в соответствии с 
вашим вкусом.

Для правильного отображения информации телетекста необходимо обеспечить стабильность приема сигнала. Иначе 
информация может отображаться не полностью или некоторые страницы могут быть пропущены.

1	 0 (режим)
Нажмите, чтобы выбрать 
режим телетекста (LIST / 
FLOF). При выборе режима 
LIST устанавливается режим 
сохранения списка. В режиме 
сохранения списка можно 
сохранять страницы телетекста 
в список с помощью кнопки 8

2	 8 (сохранить)
Используется для сохранения 
страниц телетекста.

3	 4 (размер)
Нажмите, чтобы увеличить 
шрифт в верхней половине 
экрана в два раза. Для 
уменьшения размера экрана в 
два раза нажмите снова. Для 
отображения нормального 
экрана нажмите еще раз.

4	 5 (открыть)
Используется для отображения 
скрытого текста (например, 
ответы на вопросы викторины). 
Для отображения нормального 
экрана нажмите еще раз.

5	 Цветные кнопки (красная / 
зеленая / желтая / синяя)
Если телевещательная 
компания использует систему 
FASTEXT, то различные 
разделы страницы телетекста 
будут обозначены цветами, 
и их можно будет выбрать, 
нажимая цветные кнопки. 
Нажмите кнопку, которая 
необходима. Отобразится 
соответствующая страница, 
где другим цветом выделена 
информация, которую тоже 
можно выбрать аналогичным 
образом. Чтобы отобразить 
предыдущую или следующую 
страницу, нажмите 
соответствующую цветную 
кнопку.

6	 / (отображение телетекста / 
совмещение)
Используется для активации 
режима телетекста после выбора 
канала, который предлагает услугу 
телетекста. Нажмите кнопку дважды, 
чтобы наложить телетекст на 
изображение на телеэкране.

7	 : (выход)
Выход из режима телетекста.

8	 1 (дополнительная страница)
Используется для отображения 
доступной дополнительной 
страницы.

9	 2 (страница вверх)
Используется для отображения 
следующей страницы телетекста.

0	 3 (страница вниз)
Используется для отображения 
предыдущей страницы телетекста.

!	 9 (удерживать)
Используется для сохранения на 
экране соответствующей страницы; 
если выбранная страница связана 
с несколькими дополнительными 
страницами, они будут отображаться 
одна за другой. Для возобновления 
нажмите снова.

@	 6 (главная страница)
Используется для отображения 
страницы указателя (содержания) в 
любой момент во время просмотра 
телетекста.

#	 7 (отмена)
Используется для показа 
телевизионной передачи во время 
поиска страницы.

Можно менять страницы телетекста с помощью кнопок с цифрами на пульте дистанционного управления. 
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Информация на страницах телетекста делится на шесть категорий.

Часть Содержание
A Номер выбранной страницы.
B Название канала вещания.
C Номер текущей страницы или результаты поиска.
D Дата и время.
E Текст.
F Информация о состоянии.

Информация FASTEXT.

Информация телетекста часто занимает несколько страниц, которые отображаются последовательно. Чтобы открыть 
эти страницы:

введите номер страницы;
выберите название страницы из списка;
выберите цветное заглавие (система FASTEXT).

Уровень телетекста, поддерживаемый телевизором – версия 2.5, которая позволяет отображать дополнительную 
графику или текст.
В зависимости от передаваемого сигнала, во время отображения телетекста могут отображаться пустые боковые 
панели.
В подобных случаях дополнительная графика или текст не передаются.
Телевизоры предыдущих поколений, которые не поддерживают телетекст версии 2.5, не могут отображать 
дополнительную графику или текст независимо от передачи данных телетекста.
Нажмите кнопку TV для выхода из режима телетекста.

Установка подставки
Предварительная настройка: Поместите направляющую подставки и защитную 
насадку на подставку и закрепите их с помощью винтов. Относится только к 
моделям с диагональю экрана 32 дюйма.

1.	 Прикрепите ЖК-телевизор к подставке.
Переносить телевизор должны несколько человек.
Во время сборки не перепутайте лицевую и обратную стороны подставки.
Убедитесь, что телевизор установлен на подставке на надлежащем уровне. 
Не нажимайте слишком сильно на верхний левый и правый углы экрана 
телевизора.

2.	 Затяните винты в положении 1, а затем затяните винты в положении 2.
Поставьте устройство и закрепите винты. Если при закреплении винтов 
телевизор находится в положении ЖК-экраном вниз, он может наклониться на 
один бок.
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Отсоединение подставки

1.	 Удалите четыре винта на задней панели телевизора.
2.	 Отсоедините подставку от телевизора.

Переносить телевизор должны несколько человек.
3.	 Закройте образовавшееся снизу отверстие крышкой.

Установка с помощью набора для настенного монтажа

С помощью деталей для настенного крепления (продаются отдельно) можно крепить 
телевизор на стене.
Для получения дополнительной информации относительно установки настенного 
крепления см. инструкции, прилагаемые к деталям для настенного крепления. Для 
получения помощи при установке настенного кронштейна обратитесь к специалисту 
технической поддержки.
Samsung Electronics не несет ответственности за любые повреждения изделия или 
травмы, возникшие в случае самостоятельной установки телевизора покупателем.

Не выполняйте установку набора для настенного монтажа, когда телевизор 
включен. Это может привести к травме вследствие поражения электрическим 
током.

Снимите подставку, закройте отверстие в нижней части заглушкой и закрепите два винта.

Компоновка кабелей

Поместите кабели в держатель проводов, чтобы их не было видно сквозь прозрачную 
подставку.

Замок Kensington для защиты от краж

Замок Kensington – это устройство для физического закрепления системы, когда 
она используется в общественных местах. Внешний вид и способ блокировки могут 
отличаться от изображения в зависимости от производителя.
Для получения сведений об использовании замка Kensington см. прилагаемое 
руководство пользователя. 

Такое устройство приобретается дополнительно.
Размещение замка Kensington может отличаться в зависимости от его модели.

1.	 Вставьте устройство блокировки в гнездо для замка Kensington, расположенное на 
ЖК-экране телевизора (рисунок 1), и поверните его по часовой стрелке (рисунок 
2).

2.	 Подсоедините кабель замка Kensington (рисунок 3).
3.	 Прикрепите замок Kensington к столу или тяжелому стационарному предмету.
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крепление телевизора на стене

Внимание: Нельзя тянуть, толкать или приподнимать телевизор, поскольку телевизор может упасть. 
Следите за тем, чтобы дети не облокачивались на телевизор и не раскачивали его, поскольку 
телевизор может опрокинуться и привести к серьезным и даже смертельным травмам. Соблюдайте 
все меры предосторожности, описанные в прилагаемой брошюре по безопасности. Для обеспечения 
дополнительной устойчивости в целях безопасности установите приспособление против скольжения, как 
описано далее.

во избежание падения телевизора следует выполнить следующие действия.
1. Вставьте винты в зажимы и надежно закрепите их на стене. Убедитесь, что 

винты надежно закреплены в стене.
В зависимости от типа стены может потребоваться дополнительный 
материал, например, дюбель.
Поскольку необходимые зажимы, винты и трос не входят в комплект 
поставки, их необходимо приобретать отдельно.

2. Удалите винты из середины задней панели телевизора, вставьте винты в 
зажимы, затем снова закрепите винты на телевизоре.

Винты могут не входить в комплект поставки телевизора. В этом случае 
необходимо приобрести винты со следующими характеристиками. 
Характеристики винтов
Для телевизоров с ЖК-экраном 17 ~ 29 дюймов: M4 X 15/для телевизоров с 
ЖК-экраном 32 ~ 40 дюймов: M6 X 15

3. Закрепите зажимы, прикрепленные к телевизору, и зажимы, прикрепленные к 
стене, с помощью крепкого троса, а затем надежно завяжите его.

Установите телевизор рядом со стеной, чтобы он не упал назад.
Прикрепление троса будет безопасным, если зажимы на стене будут 
находиться на одном уровне или ниже зажимов на телевизоре.
Перед тем, как перемещать телевизор, развяжите трос.

4. Убедитесь, что все соединения зафиксированы надлежащим образом. Периодически проверяйте соединения на 
предмет каких-либо признаков неисправности. Если у вас возникают сомнения по поводу безопасности соединений, 
обратитесь к квалифицированному специалисту по установке.
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Поиск и устранение неисправностей: перед обращением в службу технической поддержки

Отсутствует звук или 
изображение

Проверьте надежность подсоединения шнура электропитания.
Проверьте, нажата ли на телевизоре кнопка включения питания.
Проверьте значения параметров контрастности и яркости.
Проверьте уровень громкости.

Изображение нормальное, но 
звук отсутствует

Проверьте уровень громкости.
Проверьте, не была ли нажата кнопка MUTEM на пульте дистанционного управления.
Проверьте настройки Выбрать громкогов..

Экран остается черным, а 
индикатор питания мигает

Проверьте наличие питания в компьютере и состояние сигнального кабеля.
В телевизоре применяется система управления питанием.
Переместите мышь или нажмите любую клавишу на клавиатуре.

Нет изображения или 
изображение черно-белое

Отрегулируйте настройки цвета.
Убедитесь, что выбрана правильная система телевещания.

Помехи в звуке и изображении Попытайтесь найти электрическое устройство, которое влияет на телевизор, и переставьте это 
устройство подальше.
Подсоедините телевизор к другой розетке сети питания.

Размытое изображение или 
наличие помех типа «снег», а 
также искажен звук

Проверьте направление, месторасположение и подключение своей антенны.
Подобные помехи часто возникают при использовании комнатной антенны.

Неисправности в работе пульта 
дистанционного управления

Замените батареи в пульте дистанционного управления.
Почистите верхнюю часть пульта дистанционного управления (окно передачи сигнала).
Проверьте контакты батарей.

Отображается сообщение 
о необходимости проверки 
сигнального кабеля.

Убедитесь, что сигнальный кабель надежно подсоединен к компьютеру или другому источнику 
видеосигнала.
Убедитесь, что компьютер или другой источник видеосигнала включен.

В режиме PC отображается 
сообщение о том, что режим не 
поддерживается.

Проверьте максимальное значение разрешения и частоту видеоадаптера.
Сравните эти величины с данными, которые отображаются в режимах отображения.

В углах экрана изображение 
искажено

Если на некоторых внешних устройствах выбран параметр По разм. экрана, в углах экрана 
изображение может быть искаженным. Этот симптом связан с внешними устройствами, а не 
телевизором.

Отображается сообщение о 
восстановлении значений по 
умолчанию для всех настроек.

Отображается при нажатии кнопки EXIT и удержании ее в течение некоторого времени. Для 
параметров устройства восстанавливаются заводские настройки по умолчанию.

Если посмотреть на край 
панели вокруг экрана 
телевизора с близкого 
расстояния, можно заметить 
небольшие частицы.

Это является особенностью конструкции и не свидетельствует о дефекте.

ЖК-панель с TFT-матрицей состоит из множества подпикселов (6 220 800), и ее изготовление требует применения 
наиболее совершенных технологий. Однако на экране может быть несколько темных или светлых пикселов. Эти 
отдельные пикселы не влияют на качество работы устройства.
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Характеристики

Название модели LE32B550A, LE32B551A
LE32B553M, LE32B554M

LE37B550A, LE37B551A
LE37B553M, LE37B554M

Размер экрана 
(диагональ) 32 дюйма 37 дюймов
Разрешение экрана ПК
(оптимальное) 1920 x 1080 при частоте 60 Гц 1920 x 1080 при частоте 60 Гц
Звук
(Выход) 10 Вт х 2 10 Вт х 2
Размеры (ШxГxВ)
Корпус
С подставкой

794 X 77 X 524 мм
794 X 240 X 570 мм

917 X 79 X 592 мм
917 X 255 X 658 мм

Вес
С подставкой 13 дюймов 16 дюймов
Условия окружающей среды
Рабочая температура
Относительная влажность при работе
Температура хранения
Влажность воздуха в помещении для хранения

От 10°C до 40°C (от 50°F до 104°F)
10% – 80%, без конденсации

От -20°C до 45°C (от -4°F до 113°F)
5% – 95%, без конденсации

Шарнирная подставка
(Левая / правая) -20˚ ~ 20˚

Название модели LE40B550A, LE40B551A
LE40B553M, LE40B554M

LE46B550A, LE46B551A
LE46B553M, LE46B554M

Размер экрана 
(диагональ) 40 дюймов 46 дюймов
Разрешение экрана ПК
(оптимальное) 1920 x 1080 при частоте 60 Гц 1920 x 1080 при частоте 60 Гц
Звук
(Выход) 10 Вт х 2 10 Вт х 2
Размеры (ШxГxВ)
Корпус
С подставкой

982 X 79 X 626 мм
982 X 255 X 676 мм

1116 X 79 X 706 мм
1116 X 27 5 X 770 мм

Вес
С подставкой 18 дюймов 23 дюймов
Условия окружающей среды
Рабочая температура
Относительная влажность при работе
Температура хранения
Влажность воздуха в помещении для хранения

От 10°C до 40°C (от 50°F  до 104°F)
10% – 80%, без конденсации

От -20°C до 45°C (от -4°F до 113°F)
5% – 95%, без конденсации

Шарнирная подставка
(Левая / правая) -20˚ ~ 20˚

Конструкция и характеристики устройства могут изменяться без предварительного уведомления.
Данное устройство является цифровым устройством класса В.
Характеристики электропитания и потребления электроэнергии указаны на наклейке на корпусе устройства.
Подлежит использованию по назначению в нормальных условиях. 
Срок службы : 7лет
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